Software

SuperDrive G2 15.1.0.4776

User’s Manual
# Contents

1. **SuperDrive G2**  
   1. Welcome  
   2. Contact  

2. **Introduction**  
   1. System Requirements  
   2. Supported Drives  

3. **Getting to Know the Environment**  
   1. Main Window  
   2. Project Tree  

4. **Safety**  
   1. Safety Notice  
   2. Copyright Notice  

5. **What’s New**  
   1. What’s New in this Version  
   2. What’s New in Previous Versions  

6. **Installation/Uninstallation**  
   1. Before Installing  
   2. Installing  
   3. Uninstalling  
   4. USB Driver  

7. **Menus**  
   1. Project  
      - New  
      - Open  
      - Close  
      - Save  
      - Save As  
      - Remove  
      - Import  
      - Export  
      - Change Voltage  
      - Print  
      - Project Information  
      - Exit  
   2. Drive  
      - Identify Drive  
      - Communication Setup  
      - Security System  

---

SuperDrive G2 15.1.0.4776 | 3
Security System (Session) ................................................................................................. 64
New Parameters File ........................................................................................................ 64
Edit Parameters File ........................................................................................................ 65
Remove Parameters File ................................................................................................. 68
Export Parameters File ................................................................................................. 69
Read Parameters from Drive .......................................................................................... 70
Write Parameters to Drive ............................................................................................. 71
Monitor Parameters ........................................................................................................ 75
Monitor using Keypad ...................................................................................................... 77
Monitor Status ................................................................................................................ 78
Monitor Speed Reference .............................................................................................. 83
Trend ................................................................................................................................. 84
Remove Trend File .......................................................................................................... 92
Export Trend File ............................................................................................................ 92
Trace ................................................................................................................................. 93
Remove Trace File ......................................................................................................... 96
Export Trace File ............................................................................................................ 96
3 Tools ............................................................................................................................. 97
Options ............................................................................................................................. 97
Import Database ............................................................................................................. 101
Convert Project .............................................................................................................. 101
Simplified Conversion Log ............................................................................................ 106
Remove Simplified Conversion Log ............................................................................. 108
Full Conversion Log ....................................................................................................... 108
Remove Full Conversion Log ....................................................................................... 110
4 Help ............................................................................................................................ 110
Contents ......................................................................................................................... 110
About ............................................................................................................................... 111
8 Communication .......................................................................................................... 113
1 Drive Parametrization ................................................................................................. 113
2 USB Connection .......................................................................................................... 116
3 USB Connection - Virtual COM Port .......................................................................... 118
4 RS232 Connection ....................................................................................................... 130
5 RS485 Connection ....................................................................................................... 133
6 Bluetooth Connection ................................................................................................. 148
7 Ethernet Connection ................................................................................................. 173
8 RS232 Cable ............................................................................................................... 207
9 USB Cable .................................................................................................................. 207
10 Ethernet Cable .......................................................................................................... 210
11 USB to Serial Adapter .............................................................................................. 210
12 Bluetooth USB Adapter ........................................................................................... 211
13 Ethernet Network Adapter ....................................................................................... 212
14 Before Trying to Establish Communication .............................................................. 214
15 Exception During Monitoring .................................................................................. 214
9 Context menus ........................................................................................................... 215
1 Project .......................................................................................................................... 215
   Rename ....................................................................................................................... 215
   Save As ....................................................................................................................... 216
   Close .......................................................................................................................... 217
10 Libraries ..................................................................................................................... 218
Contents

1  JFreeChart .............................................................. 218
2  jSSC .............................................................. 218
1 SuperDrive G2

Contents of this chapter:

Welcome
Contact

Start

Click the Welcome button to start.

Welcome

1.1 Welcome

Welcome to SuperDrive G2 15.1.0.4776!

Thank you for using SuperDrive G2, a windows based graph tool for parameter setting, command and monitoring of drives.

SuperDrive G2 is a computer tool for making the use of drives as easy and convenient as possible.

SuperDrive G2 provides user-friendly tools for viewing, manipulating, and exchanging data with the drive. Data can be retrieved, changed and stored.

Main Features

- Online identification of connected drive;
- Offline configuration of drive;
- Parameter transfer from computer to the drive;
- Parameter transfer from drive to the computer;
- Offline editing of the parameters stored on the computer;
- Online editing of the parameters in drive;
- Monitoring of the drive status;
- Command operations (motor stop/run, jog, forward/reverse, local/remote, etc);
- Supports multiple databases for standard and special firmware version;
- RS232, RS485, USB and Ethernet point-to-point serial communication;
- Graphical monitoring of parameters;
- Configuration, import and visualization of variables stored in Trace function of the drive (CFW-11, CFW-11M G2, SCA-06 and CTW900)
- Project importation and exportation;
- Project conversion;
- Online help.

NOTE!
Some features are not available in all drives.
1.2 Contact

SuperDrive G2 15.1.0.4776
Technical Support: Contact a local branch or representative.
Contact Us: http://www.weg.net/
Publication Date: 04/2019
2 Introduction

Contents of this chapter:

System Requirements
Supported Drives
User’s Manual

2.1 System Requirements

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>1 GHz or faster processor</td>
</tr>
<tr>
<td>Operating System</td>
<td>Windows 7 / 8 / 8.1 / 10 (x86, x64) with latest service pack available or upgrade You must have administrator privileges to install the software</td>
</tr>
<tr>
<td>Memory</td>
<td>Windows (x86) - 1 GB or more recommended</td>
</tr>
<tr>
<td></td>
<td>Windows (x64) - 2 GB or more recommended</td>
</tr>
<tr>
<td>Display Color</td>
<td>High color resolution (16 bits) or more</td>
</tr>
<tr>
<td>Display Resolution</td>
<td>1024x768 pixels</td>
</tr>
<tr>
<td></td>
<td>1280x1024 pixels or higher-resolution screen recommended</td>
</tr>
<tr>
<td>Disk Space</td>
<td>2 GB of free disk space</td>
</tr>
<tr>
<td>Pointing Device</td>
<td>Mouse or compatible pointing device</td>
</tr>
<tr>
<td>Java Runtime Environment</td>
<td>It is not necessary to install java; SuperDrive G2 already includes a suitable JRE 8.</td>
</tr>
<tr>
<td>Internet Browser</td>
<td>Mozilla Firefox 66 or greater</td>
</tr>
<tr>
<td></td>
<td>Opera 58 or greater</td>
</tr>
<tr>
<td></td>
<td>Internet Explorer 9/10/11 (Windows 7)</td>
</tr>
<tr>
<td></td>
<td>Internet Explorer 10/11 (Windows 8, 8.1)</td>
</tr>
<tr>
<td></td>
<td>Internet Explorer 11 (Windows 10)</td>
</tr>
<tr>
<td></td>
<td>JavaScript enabled</td>
</tr>
<tr>
<td></td>
<td>Browser should support Cascading Style Sheets (CSS1) and JavaScript</td>
</tr>
<tr>
<td>Printer</td>
<td>Inkjet or laser compatible with the OS; required only if need printing data.</td>
</tr>
</tbody>
</table>

(x86) = 32-bit Edition.
(x64) = 64-bit Edition.

2.2 Supported Drives

The following table shows drives and firmware versions that each database supplied with SuperDrive G2 supports.

<table>
<thead>
<tr>
<th>Drive</th>
<th>SuperDrive G2</th>
</tr>
</thead>
<tbody>
<tr>
<td>CFW-11</td>
<td>15.1.0.4776</td>
</tr>
<tr>
<td>---------------</td>
<td>------------</td>
</tr>
<tr>
<td>1.0X</td>
<td>X</td>
</tr>
<tr>
<td>1.1X</td>
<td>X</td>
</tr>
<tr>
<td>1.3X</td>
<td>X</td>
</tr>
<tr>
<td>1.6X</td>
<td>X</td>
</tr>
<tr>
<td>2.0X</td>
<td>X</td>
</tr>
<tr>
<td>2.46</td>
<td>X</td>
</tr>
<tr>
<td>2.50</td>
<td>X</td>
</tr>
<tr>
<td>2.51</td>
<td>X</td>
</tr>
<tr>
<td>3.0X</td>
<td>X</td>
</tr>
<tr>
<td>3.11</td>
<td>X</td>
</tr>
<tr>
<td>3.12</td>
<td>X</td>
</tr>
<tr>
<td>3.1X</td>
<td>X</td>
</tr>
<tr>
<td>3.30</td>
<td>X</td>
</tr>
<tr>
<td>3.31</td>
<td>X</td>
</tr>
<tr>
<td>3.32</td>
<td>X</td>
</tr>
<tr>
<td>3.33</td>
<td>X</td>
</tr>
<tr>
<td>3.35</td>
<td></td>
</tr>
<tr>
<td>3.36</td>
<td>X</td>
</tr>
<tr>
<td>3.4X</td>
<td>X</td>
</tr>
<tr>
<td>3.7X</td>
<td>X</td>
</tr>
<tr>
<td>3.8X</td>
<td>X</td>
</tr>
<tr>
<td>15.16</td>
<td>X</td>
</tr>
<tr>
<td>15.30</td>
<td>X</td>
</tr>
<tr>
<td>15.78</td>
<td>X</td>
</tr>
<tr>
<td>15.84</td>
<td>X</td>
</tr>
<tr>
<td>15.90</td>
<td>X</td>
</tr>
<tr>
<td>15.91</td>
<td>X</td>
</tr>
<tr>
<td>15.97</td>
<td>X</td>
</tr>
<tr>
<td>45.11</td>
<td>X</td>
</tr>
<tr>
<td>45.12</td>
<td>X</td>
</tr>
<tr>
<td>45.80</td>
<td>X</td>
</tr>
<tr>
<td>55.20</td>
<td>X</td>
</tr>
<tr>
<td>55.82</td>
<td>X</td>
</tr>
<tr>
<td>65.1X</td>
<td>X</td>
</tr>
<tr>
<td>65.83</td>
<td>X</td>
</tr>
<tr>
<td>85.32</td>
<td>X</td>
</tr>
<tr>
<td>85.82</td>
<td>X</td>
</tr>
<tr>
<td>85.84</td>
<td>X</td>
</tr>
<tr>
<td>85.90</td>
<td>X</td>
</tr>
<tr>
<td>CFW-11RB</td>
<td></td>
</tr>
<tr>
<td>2.0X</td>
<td>X</td>
</tr>
<tr>
<td>2.1X</td>
<td>X</td>
</tr>
<tr>
<td>CFW-11M G2</td>
<td>1.1X</td>
</tr>
<tr>
<td>CFW701</td>
<td>1.2X</td>
</tr>
<tr>
<td>Model</td>
<td>Version</td>
</tr>
<tr>
<td>-----------</td>
<td>---------</td>
</tr>
<tr>
<td>CFW700</td>
<td>2.0X</td>
</tr>
<tr>
<td></td>
<td>2.1X</td>
</tr>
<tr>
<td></td>
<td>12.07</td>
</tr>
<tr>
<td>CFW500</td>
<td>1.0X</td>
</tr>
<tr>
<td></td>
<td>1.2X</td>
</tr>
<tr>
<td></td>
<td>2.00</td>
</tr>
<tr>
<td></td>
<td>2.0X</td>
</tr>
<tr>
<td></td>
<td>2.2X</td>
</tr>
<tr>
<td>CFW501</td>
<td>1.3X</td>
</tr>
<tr>
<td></td>
<td>1.5X</td>
</tr>
<tr>
<td></td>
<td>1.8X</td>
</tr>
<tr>
<td>CFW100</td>
<td>1.1X</td>
</tr>
<tr>
<td></td>
<td>2.0X</td>
</tr>
<tr>
<td></td>
<td>2.1X</td>
</tr>
<tr>
<td></td>
<td>2.2X</td>
</tr>
<tr>
<td></td>
<td>2.3X</td>
</tr>
<tr>
<td></td>
<td>2.4X</td>
</tr>
<tr>
<td>MW500</td>
<td>1.5X</td>
</tr>
<tr>
<td></td>
<td>1.60</td>
</tr>
<tr>
<td></td>
<td>2.0X</td>
</tr>
<tr>
<td>ECW500</td>
<td>1.0X</td>
</tr>
<tr>
<td></td>
<td>1.1X</td>
</tr>
<tr>
<td></td>
<td>1.3X</td>
</tr>
<tr>
<td>PLC11-01</td>
<td>1.0X</td>
</tr>
<tr>
<td></td>
<td>1.2X</td>
</tr>
<tr>
<td></td>
<td>1.4X</td>
</tr>
<tr>
<td></td>
<td>1.7X</td>
</tr>
<tr>
<td>PLC11-02</td>
<td>1.0X</td>
</tr>
<tr>
<td></td>
<td>1.2X</td>
</tr>
<tr>
<td></td>
<td>1.4X</td>
</tr>
<tr>
<td></td>
<td>1.7X</td>
</tr>
<tr>
<td>CTW900</td>
<td>1.0X</td>
</tr>
<tr>
<td></td>
<td>1.1X</td>
</tr>
<tr>
<td>SCA-06</td>
<td>1.1X</td>
</tr>
<tr>
<td></td>
<td>1.2X</td>
</tr>
<tr>
<td></td>
<td>1.4X</td>
</tr>
<tr>
<td></td>
<td>1.5X</td>
</tr>
<tr>
<td></td>
<td>1.7X</td>
</tr>
<tr>
<td>SSW-06</td>
<td>1.3X</td>
</tr>
<tr>
<td></td>
<td>1.4X</td>
</tr>
<tr>
<td></td>
<td>1.6X</td>
</tr>
<tr>
<td></td>
<td>1.7X</td>
</tr>
<tr>
<td></td>
<td>1.8X</td>
</tr>
<tr>
<td>SSW-07</td>
<td>1.2X</td>
</tr>
<tr>
<td></td>
<td>1.3X</td>
</tr>
<tr>
<td></td>
<td>1.4X</td>
</tr>
<tr>
<td></td>
<td>1.5X</td>
</tr>
<tr>
<td>SSW-08</td>
<td>1.3X</td>
</tr>
<tr>
<td></td>
<td>1.4X</td>
</tr>
<tr>
<td></td>
<td>1.5X</td>
</tr>
<tr>
<td>SSW7000</td>
<td>1.1X</td>
</tr>
</tbody>
</table>
Introduction

As new firmware versions are created, additional databases are added to SuperDrive G2.

The additional databases can be found on the Internet at the manufacturer's web site (see Contact).

If your drive uses a special firmware version (customized version), SuperDrive G2 needs an additional database. Request this additional database for the manufacturer.

The software allows communication only with the drive types listed in the above table.

Firmware is the software which controls the drive. To find out which is the firmware version, read parameter P0023.

Older Versions

The following tables show drives and firmware versions that each database supplied with SuperDrive G2 supports.

<table>
<thead>
<tr>
<th>Drive</th>
<th>SuperDrive G2</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>12.0.0</td>
</tr>
<tr>
<td>CFW-11</td>
<td></td>
</tr>
<tr>
<td>1.0X</td>
<td>X</td>
</tr>
<tr>
<td>1.1X</td>
<td>X</td>
</tr>
<tr>
<td>1.3X</td>
<td>X</td>
</tr>
<tr>
<td>1.6X</td>
<td>X</td>
</tr>
<tr>
<td>2.0X</td>
<td>X</td>
</tr>
<tr>
<td>2.46</td>
<td>X</td>
</tr>
<tr>
<td>2.50</td>
<td>X</td>
</tr>
<tr>
<td>2.51</td>
<td>X</td>
</tr>
<tr>
<td>3.0X</td>
<td>X</td>
</tr>
<tr>
<td>3.11</td>
<td>X</td>
</tr>
<tr>
<td>3.12</td>
<td>X</td>
</tr>
<tr>
<td>3.1X</td>
<td>X</td>
</tr>
<tr>
<td>3.30</td>
<td>X</td>
</tr>
<tr>
<td>3.31</td>
<td>X</td>
</tr>
<tr>
<td>3.32</td>
<td>X</td>
</tr>
<tr>
<td>3.33</td>
<td>X</td>
</tr>
<tr>
<td>3.5X</td>
<td>X</td>
</tr>
<tr>
<td>3.90</td>
<td>X</td>
</tr>
<tr>
<td>Model</td>
<td>Version</td>
</tr>
<tr>
<td>------------</td>
<td>---------</td>
</tr>
<tr>
<td>CFW-11RB</td>
<td>2.0X</td>
</tr>
<tr>
<td></td>
<td>2.1X</td>
</tr>
<tr>
<td>CFW-11M G2</td>
<td>1.1X</td>
</tr>
<tr>
<td>CFW701</td>
<td>1.2X</td>
</tr>
<tr>
<td></td>
<td>2.0X</td>
</tr>
<tr>
<td></td>
<td>2.1X</td>
</tr>
<tr>
<td></td>
<td>12.07</td>
</tr>
<tr>
<td>CFW700</td>
<td>1.0X</td>
</tr>
<tr>
<td></td>
<td>1.2X</td>
</tr>
<tr>
<td></td>
<td>2.00</td>
</tr>
<tr>
<td></td>
<td>2.0X</td>
</tr>
<tr>
<td></td>
<td>2.2X</td>
</tr>
<tr>
<td>CFW500</td>
<td>1.1X</td>
</tr>
<tr>
<td></td>
<td>1.5X</td>
</tr>
<tr>
<td></td>
<td>1.8X</td>
</tr>
<tr>
<td></td>
<td>2.0X</td>
</tr>
<tr>
<td>CFW501</td>
<td>1.3X</td>
</tr>
<tr>
<td></td>
<td>1.5X</td>
</tr>
<tr>
<td></td>
<td>1.8X</td>
</tr>
<tr>
<td>Model</td>
<td>1.1X</td>
</tr>
<tr>
<td>-----------</td>
<td>------</td>
</tr>
<tr>
<td>CFW100</td>
<td></td>
</tr>
<tr>
<td>MW500</td>
<td></td>
</tr>
<tr>
<td>ECW500</td>
<td></td>
</tr>
<tr>
<td>PLC11-01</td>
<td></td>
</tr>
<tr>
<td>PLC11-02</td>
<td></td>
</tr>
<tr>
<td>CTW900</td>
<td></td>
</tr>
<tr>
<td>SCA-06</td>
<td></td>
</tr>
<tr>
<td>SSW-06</td>
<td></td>
</tr>
<tr>
<td>SSW-07</td>
<td></td>
</tr>
<tr>
<td>SSW-08</td>
<td></td>
</tr>
<tr>
<td>SSW7000</td>
<td></td>
</tr>
<tr>
<td>CFW-09 PM</td>
<td></td>
</tr>
<tr>
<td>Drive</td>
<td>SuperDrive G2</td>
</tr>
<tr>
<td>----------</td>
<td>---------------</td>
</tr>
<tr>
<td></td>
<td>11.0.0</td>
</tr>
<tr>
<td>CFW-11</td>
<td></td>
</tr>
<tr>
<td>1.0X</td>
<td>X</td>
</tr>
<tr>
<td>1.1X</td>
<td>X</td>
</tr>
<tr>
<td>1.3X</td>
<td>X</td>
</tr>
<tr>
<td>1.6X</td>
<td>X</td>
</tr>
<tr>
<td>2.0X</td>
<td>X</td>
</tr>
<tr>
<td>2.46</td>
<td>X</td>
</tr>
<tr>
<td>2.50</td>
<td>X</td>
</tr>
<tr>
<td>2.51</td>
<td>X</td>
</tr>
<tr>
<td>3.0X</td>
<td>X</td>
</tr>
<tr>
<td>3.11</td>
<td>X</td>
</tr>
<tr>
<td>3.12</td>
<td>X</td>
</tr>
<tr>
<td>3.1X</td>
<td>X</td>
</tr>
<tr>
<td>3.30</td>
<td>X</td>
</tr>
<tr>
<td>3.31</td>
<td>X</td>
</tr>
<tr>
<td>3.32</td>
<td>X</td>
</tr>
<tr>
<td>3.33</td>
<td>X</td>
</tr>
<tr>
<td>3.5X</td>
<td>X</td>
</tr>
<tr>
<td>3.90</td>
<td>X</td>
</tr>
<tr>
<td>4.01</td>
<td>X</td>
</tr>
<tr>
<td>4.10</td>
<td>X</td>
</tr>
<tr>
<td>4.20</td>
<td>X</td>
</tr>
<tr>
<td>5.1X</td>
<td>X</td>
</tr>
<tr>
<td>5.30</td>
<td>X</td>
</tr>
<tr>
<td>5.31</td>
<td>X</td>
</tr>
<tr>
<td>5.4X</td>
<td>X</td>
</tr>
<tr>
<td>65.1X</td>
<td>X</td>
</tr>
<tr>
<td>CFW701</td>
<td></td>
</tr>
<tr>
<td>1.2X</td>
<td>X</td>
</tr>
<tr>
<td>2.0X</td>
<td>X</td>
</tr>
<tr>
<td>CFW700</td>
<td></td>
</tr>
<tr>
<td>1.0X</td>
<td>X</td>
</tr>
<tr>
<td>1.2X</td>
<td>X</td>
</tr>
<tr>
<td>2.00</td>
<td>X</td>
</tr>
<tr>
<td>2.0X</td>
<td>X</td>
</tr>
<tr>
<td>CFW500</td>
<td></td>
</tr>
<tr>
<td>1.1X</td>
<td>X</td>
</tr>
<tr>
<td>1.5X</td>
<td>X</td>
</tr>
<tr>
<td>CFW501</td>
<td></td>
</tr>
<tr>
<td>1.3X</td>
<td>X</td>
</tr>
<tr>
<td>1.5X</td>
<td>X</td>
</tr>
<tr>
<td>CFW100</td>
<td></td>
</tr>
<tr>
<td>1.1X</td>
<td>X</td>
</tr>
<tr>
<td>2.0X</td>
<td>X</td>
</tr>
<tr>
<td>2.1X</td>
<td>X</td>
</tr>
<tr>
<td>2.2X</td>
<td>X</td>
</tr>
<tr>
<td>2.3X</td>
<td>X</td>
</tr>
<tr>
<td>MW500</td>
<td></td>
</tr>
<tr>
<td>1.5X</td>
<td>X</td>
</tr>
<tr>
<td>ECW500</td>
<td></td>
</tr>
<tr>
<td>1.0X</td>
<td>X</td>
</tr>
<tr>
<td>PLC11-01</td>
<td></td>
</tr>
<tr>
<td>1.0X</td>
<td>X</td>
</tr>
<tr>
<td>1.2X</td>
<td>X</td>
</tr>
<tr>
<td>1.4X</td>
<td>X</td>
</tr>
<tr>
<td>PLC11-02</td>
<td></td>
</tr>
<tr>
<td>1.0X</td>
<td>X</td>
</tr>
<tr>
<td>1.2X</td>
<td>X</td>
</tr>
<tr>
<td>Drive</td>
<td>1.0X</td>
</tr>
<tr>
<td>-----------</td>
<td>------</td>
</tr>
<tr>
<td>CTW900</td>
<td>X</td>
</tr>
<tr>
<td>SCA-06</td>
<td>X</td>
</tr>
<tr>
<td>SSW-06</td>
<td>X</td>
</tr>
<tr>
<td>SSW-07</td>
<td>X</td>
</tr>
<tr>
<td>SSW-08</td>
<td>X</td>
</tr>
<tr>
<td>SSW7000</td>
<td>X</td>
</tr>
<tr>
<td>CFW-09 PM</td>
<td></td>
</tr>
<tr>
<td>CFW11</td>
<td>X</td>
</tr>
<tr>
<td>CFW701</td>
<td>X</td>
</tr>
<tr>
<td>CFW700</td>
<td>X</td>
</tr>
<tr>
<td>Drive</td>
<td>SuperDrive G2</td>
</tr>
<tr>
<td>-----------</td>
<td>-----------------------</td>
</tr>
<tr>
<td></td>
<td>8.00</td>
</tr>
<tr>
<td>CFW-11</td>
<td></td>
</tr>
<tr>
<td>1.2X</td>
<td>X</td>
</tr>
<tr>
<td>2.0X</td>
<td></td>
</tr>
<tr>
<td>CFW500</td>
<td>1.1X</td>
</tr>
<tr>
<td>1.5X</td>
<td></td>
</tr>
<tr>
<td>CFW501</td>
<td>1.3X</td>
</tr>
<tr>
<td>1.5X</td>
<td></td>
</tr>
<tr>
<td>CFW100</td>
<td>1.1X</td>
</tr>
<tr>
<td>2.0X</td>
<td></td>
</tr>
<tr>
<td>2.1X</td>
<td></td>
</tr>
<tr>
<td>2.3X</td>
<td></td>
</tr>
<tr>
<td>MW500</td>
<td>1.5X</td>
</tr>
<tr>
<td>ECW500</td>
<td>1.0X</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>PLC11-01</td>
<td>1.0X</td>
</tr>
<tr>
<td>1.2X</td>
<td>X</td>
</tr>
<tr>
<td>1.4X</td>
<td></td>
</tr>
<tr>
<td>PLC11-02</td>
<td>1.0X</td>
</tr>
<tr>
<td>1.2X</td>
<td>X</td>
</tr>
<tr>
<td>1.4X</td>
<td></td>
</tr>
<tr>
<td>CTW900</td>
<td>1.0X</td>
</tr>
<tr>
<td>1.1X</td>
<td>X</td>
</tr>
<tr>
<td>1.2X</td>
<td></td>
</tr>
<tr>
<td>SCA-06</td>
<td>1.3X</td>
</tr>
<tr>
<td>1.4X</td>
<td></td>
</tr>
<tr>
<td>SSW-06</td>
<td>1.3X</td>
</tr>
<tr>
<td>1.4X</td>
<td></td>
</tr>
<tr>
<td>1.6X</td>
<td></td>
</tr>
<tr>
<td>1.7X</td>
<td></td>
</tr>
<tr>
<td>SSW-07</td>
<td>1.2X</td>
</tr>
<tr>
<td>1.3X</td>
<td></td>
</tr>
<tr>
<td>1.4X</td>
<td></td>
</tr>
<tr>
<td>SSW-08</td>
<td>1.3X</td>
</tr>
<tr>
<td>1.4X</td>
<td></td>
</tr>
<tr>
<td>SSW7000</td>
<td>1.1X</td>
</tr>
<tr>
<td>11.3X</td>
<td></td>
</tr>
<tr>
<td>12.0X</td>
<td></td>
</tr>
</tbody>
</table>

SuperDrive G2 15.1.0.4776 | 16
<table>
<thead>
<tr>
<th></th>
<th>3.1X</th>
<th>3.30</th>
<th>3.31</th>
<th>3.32</th>
<th>3.33</th>
<th>3.5X</th>
<th>3.90</th>
<th>4.01</th>
<th>4.10</th>
<th>4.20</th>
<th>5.1X</th>
<th>5.30</th>
<th>5.31</th>
<th>5.4X</th>
<th>65.1X</th>
</tr>
</thead>
<tbody>
<tr>
<td>CFW701</td>
<td>1.2X</td>
<td>2.0X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CFW700</td>
<td>1.0X</td>
<td>1.2X</td>
<td>2.0X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CFW500</td>
<td>1.1X</td>
<td>1.5X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CFW501</td>
<td>1.3X</td>
<td>1.5X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CFW100</td>
<td>1.1X</td>
<td>2.0X</td>
<td>2.1X</td>
<td>2.3X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MW500</td>
<td>1.5X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ECW500</td>
<td>1.0X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PLC11-01</td>
<td>1.0X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PLC11-02</td>
<td>1.0X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CTW900</td>
<td>1.0X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SCA-06</td>
<td>1.1X</td>
<td>1.2X</td>
<td>1.4X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SSW-06</td>
<td>1.3X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SSW-07</td>
<td>1.2X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### 2.3 User’s Manual

The user's manual, in several formats, can be found in the folders indicated below, where the SuperDrive G2 is installed.

**PDF**

Folder: \help\en_US\PDF

Example: C:\WEG\SuperDrive G2 15.1.0.4776\help\en_US\PDF

**HTML**

Folder: \help\en_US\HTML

Example: C:\WEG\SuperDrive G2 15.1.0.4776\help\en_US\HTML

**CHM**

Folder: \help\en_US\CHM

Example: C:\WEG\SuperDrive G2 15.1.0.4776\help\en_US\CHM
3  Getting to Know the Environment

Contents of this chapter:

Main Window
Project Tree

3.1  Main Window

The main window allows accessing and navigating specific areas of the application.

On the main window, the user can create and open drive (equipments) projects with several functionalities, depending on the availability of each drive.

The main window contains the following elements:

01  - Menu Bar: allows access to the software commands; the commands are accessible under certain conditions.

02  - Toolbar: displays buttons that quickly access an application command.

03  - Panel with Checkboxes: displays or hides other panels.

04  - WEG Web Site: click to open the WEG website in the browser.

05  - Help Panel: displays help in 3 languages English, Spanish, Portuguese, in html, chm and pdf formats.

06  - Project panel: shows the project name and its path.

07  - Communication panel: shows the selected connection type and settings.

08  - Project tree: shows the project with the drive information and file list.

09  - Appearance panel: shows position, language and look & feel buttons.

10  - Status Bar: located at the bottom of the screen. The status bar provides a description of the command or button on which the cursor is placed.
3.2 Project Tree

The project tree contains the following elements:

01 - Project Name: the name of the project given by the user when saving the file for the first time.

02 - Drive Identification: the drive model that displays the device name, firmware version, and rated voltage and current. Some drives may not contain the rated voltage and/or rated current.

03 - par extension file: parameter file.

04 - trend extension file: file with the trend graphic.

05 - trace extension file: file with the trace graphic.
Getting to Know the Environment
4 Safety

Contents of this chapter:

Safety Notice
Copyright Notice

4.1 Safety Notice

The use of this software can change the operation or the performance of the drive. The user is responsible for the adoption of all necessary precautions to ensure the safety of the equipment and involved personnel. Before this Software is used, read carefully all Instruction of the Online Help. The non observation of these instructions can cause serious damages to the equipment and result in serious personnel injuries.

4.2 Copyright Notice

This computer program is protected by copyright law and international treaties. Unauthorized reproduction or distribution of this program, or any portion of it, may result in severe civil and criminal penalties, and will be prosecuted to the maximum extent possible under law.
5  What's New

Contents of this chapter:

What's New - This Version
What's New - Previous Versions

5.1  What's New in this Version

SuperDrive G2 15.1.0.4776
04/02/2019

New Features:

- Communication with CFW-11 V5.35 was included,
- Communication with CFW-11 V5.36 was included,
- Communication with CFW-11 V55.20 was included,
- Communication with CFW-11 V65.83 was included.

Improvements:

- Database was improved for CFW500 V2.0X,
- Database was improved for MW500 V2.0X,
- Java - JRE update from V1.8.0_192 to V1.8.0_202.

Bugfixes:

- Correction of the Trace function whose graph presented incorrect values,
- Serial communication where communication did not work for modbus addresses larger than 1.

5.2  What's New in Previous Versions

SuperDrive G2 15.0.0.4707
11/09/2018

New Features:

- Communication on Ethernet network: CFW-11, CFW500, MW500, SCA-06 and ECW500,
- Communication with the new product CFW-11M G2 V1.1X,
- Communication with CFW-11 V85.90 was included,
- Communication with CFW-11 V85.84 was included,
- Communication with CFW-11 V55.82 was included,
- Communication with CFW-11 V45.80 was included,
- Communication with CFW-11 V15.30 was included,
- Communication with CFW-11RB V2.1X was included,
- Communication with CFW700 V2.2X was included,
- Communication with CFW701 V2.1X was included,
- Communication with MW500 V2.0X was included,
- Communication with ECW500 V1.3X was included.

Improvements:
What's New

- New information added to the main window: project, project path, communication, centering button, centering and expanding button, languages, selection of look&feel, buttons for help in various formats and languages.
- About window - new information on the Java in use, operating system and user was added,
- WEG USB Driver - update from V10.00 to V11.00 (automatic installation),
- FTDI USB Driver - update from V2.12.16 to V2.12.28 (automatic installation),
- Java - JRE update from V1.8.0_144 to V1.8.0_192.

Bugfixes:

- Correction on the database for CFW100 V2.3X.

SuperDrive G2 14.0.0.3677
09/26/2017

New Features:

- Project Conversion;
- Added communication with CFW11 V15.78;
- Added communication with CFW11 V85.82;
- Added communication with CFW701 V12.07;
- Added communication with MW500 V1.60;
- Added communication with SCA-06 V1.7X;
- Added communication with SSW7000 V1.6X.

Improvements:

- Trend function - improved performance when browsing the chart;
- Java - update JRE from V1.8.0_102 to V1.8.0_144;
- Some icons were updated;
- Database update for CFW700 V1.2X;
- Database update for CFW501 V1.8X;
- Minor visual update - about, project information, writing parameters to drive, offline parameters editor and monitoring parameters window.

Bugfixes:

- Database correction for CFW700 V2.0X;
- Database correction for CFW500 V2.0X.

SuperDrive G2 13.0.0.3103
09/26/2016

New Functions:

- Compatible with Windows 10;
- Added communication with CFW11 V5.7X;
- Added communication with CFW11 V5.33;
- Added communication with SSW7000 V1.5x.

Enhancements:

- Trend function - improved performance when browsing the chart;
- WEG USB Driver V10.00 - new version with automatic installation;
- FTDI USB Driver V2.12.16 - new version with automatic installation;
- Java - update JRE from V1.8.0_74 to V1.8.0_102.
Corrections:

- ECW500 - Status Window, modifications: from "Start" to "On", from "Stop" to "Off";
- Database correction for CFW700 V2.0X;
- Database correction for CFW500 V2.0X;
- Database correction for CFW500 V1.8X;
- Database correction for ECW500 V1.1X;

**SuperDrive G2 12.1.0**  
03/14/2016

New Functions:

- Communication with CFW-11RB V2.0X;
- Communication with ECW500 V1.1X;
- Communication with CFW500 V2.0X;
- Communication with CFW-11 V85.32;
- Communication with CFW-11 V5.2X;
- Communication with CFW-11 V5.8X;
- Function to import databases;
- Function search available both parameter and monitor editor.

Enhancements:

- Improvements in Trend: Graph showing with better performance and new options to pause, save, calculate instant reading time interval and new graphic display time ranges.

Corrections:

- Correction in function to Import Projects;
- Communication with CFW500 V1.8X;
- Communication with CFW501 V1.8X;
- Communication with MW500 V1.5X;
- Communication with CFW700 V2.0X.

**SuperDrive G2 12.0.0**  
09/30/2015

New Functions:

- Windows 8.1 (x86, x64) is supported;
- German language is supported;
- Function to change voltage in project (CFW11 only);
- Communication with CFW11 V4.21;
- Communication with CFW11 V15.16;
- Communication with CFW11 V15.84;
- Communication with CFW11 V15.90;
- Communication with CFW11 V15.91;
- Communication with CFW11 V15.97;
- Communication with CFW11 V45.11;
- Communication with CFW11 V45.12;
- Communication with CFW100 V2.4X;
- Communication with CFW500 V1.8X;
- Communication with CFW501 V1.8X;
- Communication with SCA-06 V1.5X;
- Communication with SSW7000 V1.3X;
What's New

SuperDrive G2 15.1.0.4776 | 26

• Communication with SSW7000 V1.4X;
• Communication with PLC11-01 V1.7X;
• Communication with PLC11-02 V1.7X;
• Communication with CTW900 V1.1X;
• Communication with SSW06 V1.8X;
• Communication with SSW07 V1.5X;
• Communication with SSW08 V1.5X.

Enhancements:

• Reduced the response time when connected with CFW11;
• Visual improvements (new icons);
• Improvement in presentation of option Projects (in Options > Projects);
• USB driver update;
• Communication with CFW11 V3.5X, added database in german language;
• Communication with CFW11 V5.4X, added database in german language;
• Communication with CFW11 V65.1X, added database in german language;
• Communication with CFW500 V1.5X, added database in german language;
• Communication with CFW700 V2.0X, added database in german language;
• Communication with MW500 V1.5X, added database in german language.

Corrections:

• Communication with CFW11 V5.4X;
• Communication with ECW500 V1.0X.

SuperDrive G2 11.3.0
09/24/2014

New Functions:

• Function Save As project;
• Function Rename project;
• New options for printing parameters;
• Function Remove project;
• Export graphics and parameters to CSV format files;
• Function Security System for CFW11 V65.1X;
• Function Trace for CTW900;
• Communication with CFW501 V1.3X;
• Communication with CFW501 V1.5X;
• Communication with CFW11 V65.1X;
• Communication with CFW11 V5.31;
• Communication with CFW700 V2.0X line 600V;
• Communication with CFW701 V2.0X line 600V;
• Communication with CFW100 V2.3X.

Enhancements:

• Added operation mode in the status window of ECW500;
• Allow change the default folder where projects are stored.

Corrections:

• Database correction of ECW500 V1.0X;
• Database correction of CFW100 V2.2X (english);
• Correction in printing parameters where overlapping characters could occur.
SuperDrive G2 11.2.0
05/21/2014

The following features were added:

- Communication with MW500 V1.5X;
- Communication with CFW100 via Bluetooth;
- Communication with CFW100 V2.2X;
- Communication with SCA-06 V1.4X;
- Communication with CFW11 V5.4X;
- Communication with CFW11 V5.30;
- Communication with CFW11 V4.20;
- Communication with CFW11 V3.30;
- Communication with CFW11 V3.31;
- Communication with CFW11 V3.32;
- Communication with CFW11 V3.33.

Minor changes:

- Correction of instability during printing parameters;
- Database correction of CFW500 V1.1X;
- Database correction of CFW500 V1.5X;
- Database correction of CFW700 V2.0X;
- Database correction of CFW701 V2.0X.

SuperDrive G2 11.1.0
02/06/2014

The following features were added:

- Communication with CFW100 V2.1X.

Minor changes:

- Correction in Trace function where there was error in the read/write configuration,
- Fix reading of parameters that were not saved correctly when the reading was taken before saving the project.

SuperDrive G2 11.0.0
12/03/2013

The following features were added:

- Compatible with Windows 8 x86, Windows 8 x64

Minor changes:

- Indication on the parameter list of what has changed (different from standard);
- Fixed the window of Speed Reference to CFW100, CFW500, CFW700/701, CFW11, CTW900, which presented incorrect values;
- Fixed the New File Parameters function (offline generation of files parameters with default values), where the parameters firmware version, rated current of the drive and rated voltage of the drive had incorrect values;
- Fixed the Trend function which stored incorrectly content 0 when reading error occurred;
- Communication with CFW701 V2.0x, database correction.
SuperDrive G2 10.00  
10/07/2013

The following features were added:

- Communication with CFW11 V5.1X.

SuperDrive G2 9.90  
09/13/2013

The following features were added:

- Communication with CFW100 V2.0X.

SuperDrive G2 9.80  
08/22/2013

The following features were added:

- Communication with CFW500 V1.5X;
- Communication with CFW700 V2.0X;
- Communication with CFW701 V2.0X;
- Communication with SSW7000 V1.2X.

SuperDrive G2 9.70  
07/12/2013

The following features were added:

- Communication with CFW-11 V3.5X.

SuperDrive G2 9.60  
07/05/2013

The following features were added:

- Communication with ECW500 V1.0X;
- Communication with CFW-11 V4.01;
- Communication with CFW-11 V4.10;
- Improved communication with drives (RS232 and RS485);
- Language change no longer requires program restart;
- Automatic loading of database on alternative language.

Minor changes:

- Communication with CFW-11 V3.1x, database correction;
- Communication with CFW100 V1.1x, database correction;
- Communication with CTW900 V1.0x, database correction;
- Several improvements in Identify Drive and Communication Setup windows.

SuperDrive G2 9.50  
10/05/2012
The following features were added:

- Communication with CFW100 V1.1X;
- Size and position of windows are saved;
- Project importation and exportation.

Minor changes:

- Communication with CFW701 V1.2X, database correction.

**SuperDrive G2 9.40**
05/03/2012

The following features were added:

- Communication with CFW11 V3.1X;
- Communication with CFW700 V1.2X.

Minor changes:

- Communication with CFW700 V1.0X, database correction.

**SuperDrive G2 9.30**
03/16/2012

The following features were added:

- Communication with CTW900 V1.0X;
- Communication with SCA-06 V1.2X.

**SuperDrive G2 9.20**
12/05/2011

The following features were added:

- Communication with CFW500 V1.1X;
- Communication with CFW701 V1.2X;
- Communication with CFW-11 V3.11;
- Communication with CFW-11 V3.12.

**SuperDrive G2 9.10**
09/27/2011

The following features were added:

- Trend in the function and Trace, minimum, maximum and legend are now saved when the graph is closed;
- Communication with CFW-11 V2.46;
- Communication with CFW-11 V2.50;
- Communication with CFW-11 V2.51;
- Communication with CFW-11 V3.90.

Minor changes:
- Communication with CFW-11 V3.0x, database correction;
- Communication with CFW700 V1.0x, database correction.

**SuperDrive G2 9.00**
05/27/2011

The following features were added:

- Offline programming.

**SuperDrive G2 8.90**
04/05/2010

The following features were added:

- Communication with CFW-11 V3.0x.

**SuperDrive G2 8.80**
02/22/2010

The following features were added:

- Communication with SSW7000 V1.1x;
- Communication with SSW-07 V1.4x;
- Communication with SSW-08 V1.4x;
- Compatible with Windows 7 x86, Windows 7 x64;
- Compatible with Windows Vista x86, Windows Vista x64;
- Compatible with Windows XP x86, Windows XP x64.

**SuperDrive G2 8.70**
10/20/2010

The following features were added:

- Communication with SCA-06 V1.1x;
- Communication with SSW-06 V1.7x.

**SuperDrive G2 8.60**
08/10/2010

The following features were added:

- Communication with CFW700 V1.0x.

**SuperDrive G2 8.50**
03/05/2010

The following features were added:

- Communication with CFW-11 V2.0x;
- Communication with CFW-11 + PLC11-01 V1.4x;
What's New

- Communication with CFW-11 + PLC11-02 V1.4x.

**SuperDrive G2 8.40**
09/08/2009

The following features were added:

- **Identify Drive** address selection,
- **Write Parameters to Drive** destination address selection;
- Communication with CFW-11 + PLC11-01 V1.2x;
- Communication with CFW-11 + PLC11-02 V1.2x;
- Communication with SSW-06 V1.6x.

**SuperDrive G2 8.33**
05/15/2009

The following features were added:

- Communication with CFW-11 + PLC11-02 V1.0x.

**SuperDrive G2 8.32**
12/18/2008

The following features were added:

- Communication with CFW-09 PM V12.0x;
- Communication with CFW-11 V1.6x.

**SuperDrive G2 8.31**
05/20/2008

The following features were added:

- Communication with CFW-11 V1.3x;
- Communication with CFW-11 + PLC11-01 V1.0x.

**SuperDrive G2 8.30**
04/16/2008

The following features were added:

- Trend function,
- Communication with CFW-09 PM V11.3x;
- Communication with SSW-07 V1.3x;
- Communication with SSW-08 V1.3x.

**SuperDrive G2 8.21**
08/31/2007

The following features were added:

- Communication with CFW-11 V1.1x;
What's New

- Communication with SSW-06 V1.4x.

SuperDrive G2 8.20  
08/01/2007

The following features were added:

- Communication with SSW-07 V1.2x;
- Communication with CFW-09 PM V10.0x;
- New baud rate for RS232: 4800 bps.

Minor changes:

- Option "Always on Top" was removed from several windows;
- New layout in monitoring windows;
- It is no more necessary to reopen the project after changing Communication Setup.

SuperDrive G2 8.11  
04/24/2007

Minor changes:

- Updated CFW-11 data base;
- New baud rate for RS232: 57600 bps.

SuperDrive G2 8.10  
03/29/2007

The following features were added:

- Communication with CFW-11 V1.0x;
- USB point-to-point serial communication;
- Reference speed monitoring of CFW-11;
- Trace function;
- Language selection: English, Portuguese and Spanish.

Minor changes:

- Monitor Parameters: a divider offers user-controlled resizing of two components: parameters and messages;
- Monitor Parameters: if the user press the right button of the mouse in the messages container, a small popup menu appears with the option to clean the messages;
- Monitor Parameters and Edit Parameters File: OK and Cancel buttons were replaced with Close button;
- Monitor Keypad: validation of parameter value;
- Monitor Keypad: the user may now type a value directly into the parameter field;
- Always on top functionality is not selected any more when a window is opened;
- Parameters conversion for hexadecimal and binary now supported.

SuperDrive G2 8.00  
12/20/2006

Initial Version:
• Automatic identification of connected drives;
• Parameter transfer from computer to the drive;
• Parameter transfer from drive to the computer;
• Offline editing of the parameters stored in files on the computer;
• Monitoring (visualization and change) of drive parameters;
• Monitoring of the drive status and command operations (motor stop/run, jog, forward/reverse, local/remote, etc);
• Supports multiple databases for special firmware version;
• RS232 point-to-point serial communication;
• Online help.
6 Installation/Uninstallation

Contents of this chapter:

Before Installing
Installing
Uninstalling
USB Driver

6.1 Before Installing

Check the following items before installing SuperDrive G2:

- If the microcomputer meets the System Requirements;
- Your antivirus software must allow you to install software;
- If the SuperDrive G2 version is compatible with your drive, see Supported Drives.

6.2 Installing

When installing a newer version of SuperDrive G2 it is recommended that you first uninstall the previous version and re-boot your system to make sure the installation executes correctly.

Close all open programs currently running to prevent interference with the installation process.

To install SuperDrive G2, please follow the steps below.

Installation

01 - You must be logged in as an administrator to install the program; if you're using a standard account, the application will fail to run;

02 - If User Account Control (UAC) is enabled (Control Panel > User Accounts > Change User Account Control Settings), you will be notified before the installer starts the installation and try to make a change in the Windows configuration; click Yes to confirm that you allow the program to make changes to your computer, otherwise you cannot install the program;

03 - You should also run the installer with elevated privileges; to do so, right-click installer displays a menu; click Run as administrator;
- Select the language and click OK.

```
Select Setup Language
```

- In the install wizard, respond to the License Agreement, then click Next.
06 - Click Next.

07 - Specify an empty folder within which to install SuperDrive G2. Verify that the installation location is correct and that you have available disk space for the installation.
08 - Confirm to create the empty folder.

The folder:
C:\WEG\SuperDrive G2 15.0.0.4672
does not exist. Would you like the folder to be created?

Yes  No

09 - Click Next.
10 - Select the program group to create program's shortcuts and click Next.

11 - Select the program's shortcuts you want as additional icons: create a desktop icon and create a quick launch icon. Click Next.
Please review or change any settings. Click Install to begin the installation.
13 - Click Finish to complete the setup.
6.3 Uninstalling

If necessary, you can uninstall SuperDrive G2 using the following procedures.

Uninstall

**NOTE!**
As indicated below, use the Programs and Features utility to remove SuperDrive G2. Do not manually delete files and folders.

**Windows 10**

The following example is executed on Windows 10. For other systems, the procedures are similar. Some data are intentionally invisible, as they vary according to the version.

01 - You must be logged in as an administrator to remove the program; if you're using a standard account (non-administrator), then you can not remove the software;

02 - If User Account Control (UAC) is enabled (Control Panel > User Accounts > Change User Account Control Settings), you will be notified before starting the removal and try to make a change in the Windows configuration; click Yes to confirm that you allow the program to make changes to your computer, otherwise you can not remove the program;

03 - Right mouse click on Start button, and then select Programs and Features option.
04 - Select SuperDrive G2 from the list and click Uninstall.
### Apps & features

<table>
<thead>
<tr>
<th>App Name</th>
<th>Size</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>SuperDrive G2 15.0.0.4672</td>
<td>1.39 GB</td>
<td>17/10/2018</td>
</tr>
<tr>
<td>Tips</td>
<td>334 KB</td>
<td>12/08/2018</td>
</tr>
<tr>
<td>TortoiseSVN 1.7.15.25753 (64 bit)</td>
<td>38.8 MB</td>
<td>17/01/2018</td>
</tr>
<tr>
<td>Voice Recorder</td>
<td>16.0 KB</td>
<td>12/08/2018</td>
</tr>
<tr>
<td>Vulkan Run Time Libraries 1.0...</td>
<td>1.56 MB</td>
<td>21/06/2018</td>
</tr>
<tr>
<td>Weather</td>
<td>16.0 KB</td>
<td>12/08/2018</td>
</tr>
<tr>
<td>Web Media Extensions</td>
<td>16.0 KB</td>
<td>12/08/2018</td>
</tr>
<tr>
<td>WEG Programming Suite 2.40</td>
<td>670 MB</td>
<td>15/06/2018</td>
</tr>
<tr>
<td>WEG USBlO Driver v11.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>WEG Equipamentos Eletricos...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>WEG</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Follow the instructions to remove the software.
6.4 USB Driver

The WEG USB driver and the FTDI USB driver (Virtual COM Port) are automatically installed during the installation of SuperDrive G2.

**WEG USB Driver**

The WEG USB driver can be found in the USB_Driver folder where SuperDrive G2 is installed.

Example: C:\WEG\SuperDrive G2 15.1.0.4776\USB_Driver\USBIO

**FTDI USB Driver**

The FTDI USB driver can be found in the USB_Driver folder where SuperDrive G2 is installed.

Example: C:\WEG\SuperDrive G2 15.1.0.4776\USB_Driver\FTDI
# Menus

Contents of this chapter:

<table>
<thead>
<tr>
<th>Project</th>
<th>Drive</th>
<th>Tools</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Identify Drive</td>
<td>Options</td>
<td>Contents</td>
</tr>
<tr>
<td>Open</td>
<td>Communication Setup</td>
<td>Import Database</td>
<td>About</td>
</tr>
<tr>
<td>Close</td>
<td>Security System</td>
<td>Convert Project</td>
<td></td>
</tr>
<tr>
<td>Save</td>
<td>Security System (Session)</td>
<td>Simplified Conversion Log</td>
<td></td>
</tr>
<tr>
<td>Save As</td>
<td>New Parameters File</td>
<td>Remove Simplified Conversion Log</td>
<td></td>
</tr>
<tr>
<td>Remove</td>
<td>Edit Parameters File</td>
<td>Full Conversion Log</td>
<td></td>
</tr>
<tr>
<td>Import</td>
<td>Remove Parameters File</td>
<td>Remove Simplified Conversion Log</td>
<td></td>
</tr>
<tr>
<td>Export</td>
<td>Export Parameters File</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change Voltage</td>
<td>Read Parameters from Drive</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Print</td>
<td>Write Parameters to Drive</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Project Information</td>
<td>Monitor Parameters</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Exit</td>
<td>Monitor using Keypad</td>
<td>Monitor Status</td>
<td>Monitor Speed Reference</td>
</tr>
<tr>
<td></td>
<td>Trend</td>
<td>Remove Trend File</td>
<td>Export Trend File</td>
</tr>
<tr>
<td></td>
<td>Export Trace File</td>
<td>Trace Function</td>
<td></td>
</tr>
</tbody>
</table>

## 7.1 Project

- New
- Open
- Close
- Save
- Save As
- Remove
- Import
- Export
- Change Voltage
- Print
- Project Information
- Exit
7.1.1 New

**ACCESS**

Toolbar: 
Menu: Project > New
Shortcut Key: Ctrl+N

**FUNCTION**

Creates a new project with a standard name.

**DESCRIPTION**

Drive Identification window is presented. See Identify Drive.

7.1.2 Open

**ACCESS**

Toolbar: 
Menu: Project > Open
Shortcut Key: Ctrl+O

**FUNCTION**

Opens a previously saved project.

**DESCRIPTION**

User must select a project folder and open the project.

The project name and the drive information are shown in the Project Window.
7.1.3 Close

ACCESS

Toolbar: 
Menu: Project > Close
Shortcut Key: none

FUNCTION

Closes the project.

DESCRIPTION

If the project contains unsaved data, a save request dialog will be shown.

7.1.4 Save

ACCESS

Toolbar: 
Menu: Project > Save
Shortcut Key: Ctrl+S
FUNCTION

Saves the project.

DESCRIPTION

Enabled if the project has unsaved changes.

When the project is first time saved, a dialog is shown with the following information:

- Name - type a name for the new project. If the specified name is invalid or already exists, a warning message will be prompted.
- Location - a default location is shown, but can be changed.
- Folder - view only.
- Description - type the project description. It can be changed later in the Project Information.

7.1.5  Save As

ACCESS

Toolbar:
Menu: Project > Save As
Shortcut Key: Ctrl+D

FUNCTION

Saves a project with different name.

DESCRIPTION

Enabled when a project is created or opened.

When Save As function runs, a dialog is shown with the following information:

- Name - type a name for the new project. If the specified name is invalid or already exists, a warning message will be prompted.
- Location - a default location is shown, but can be changed.
- Folder - view only.
- Description - type the project description. It can be changed later in the Project Information.

7.1.6  Remove

ACCESS

Toolbar: 
Menu: Project > Remove
Shortcut Key: none
**FUNCTION**

Erases the current project.

**DESCRIPTION**

Enabled when a project is open.

When Remove function runs, a confirmation dialog is shown with the following information:

- **Name** - name of the project which is going to be deleted.
- **Location** - a default location is shown.
- **Folder** - project's location is shown.
- **Description** - the project description is shown.

**Buttons**

- **OK Button**: confirms the exclusion of current project.
- **Cancel Button**: keeps the current project.

---

**7.1.7 Import**

**ACCESS**

- **Toolbar**: 
- **Menu**: Project > Import
- **Shortcut Key**: none

**FUNCTION**

Imports a previously exported project.

**DESCRIPTION**
User must select a project file with extension .sdg2z and click the Import button.

This project will be imported into the default folder for projects.

If the project or any of the files already exist, the user will receive a confirmation box to overwrite the project.

If the user chooses to overwrite the conflicting files will be overwritten, otherwise, no files will be overwritten and the project will not be imported.

If, during import of the project, another project is open, then it will be closed. If data is not saved, a confirmation window appears allowing the user to save changes, discard them, or cancel the operation.

When completed the import process, the project will be imported automatically open.

7.1.8 Export

ACCESS

Toolbar: Menu: Project > Export
Shortcut Key: none

FUNCTION

Exports the current project to a file.

DESCRIPTION

The project must be open.

Click the Export button. Initially the default filename is the name of the project, which can be changed.

Clicking the save button, the file is created with the extension .sdg2z which can be imported using the Import function.

7.1.9 Change Voltage

ACCESS

Toolbar: Menu: Project > Change Voltage
Shortcut Key: none

FUNCTION

Allow to migrate the currently opened project to a new one, with another model of CFW11
drive.

**DESCRIPTION**

User must have a project opened. This option loads an wizard to help changing the model of drive and checking its parameters. If there are no compatible drives to the current model, no options will be presented to choice.

7.1.10 Print

**ACCESS**

Toolbar: 
Menu: Project > Print
Shortcut Key: Ctrl+P

**FUNCTION**

Prints the parameters file selected in the Project Window.

**DESCRIPTION**

Prints all parameters stored in the parameters file:

- Parameter number.
- User's settings.
- Unit.

7.1.11 Project Information

**ACCESS**

Toolbar: 
Menu: Project > Project Information
Shortcut Key: Ctrl+I

**FUNCTION**

Adds or modifies project information.

**DESCRIPTION**

Shows the following information:

- Name - the name of the project. View only.
- Location - the location of the project. View only.
- Folder - the folder where the project is. View only.
- Description - type the project description.
Name, Location and folder can not be changed after it is first time saved. See Save.

Description can be changed at any time.

### 7.1.12 Exit

**ACCESS**

Toolbar: 

Menu: Project > Exit

Shortcut Key: Ctrl+Q

**FUNCTION**

Exits SuperDrive G2.

**DESCRIPTION**

SuperDrive G2 asks the user if he wishes to exit.

If the project contains unsaved data, a save request dialog will be shown.

### 7.2 Drive

- Identify Drive
- Communication Setup
- Security System
- Security System (Session)
- New Parameters File
- Edit Parameters File
- Remove Parameters File
- Export Parameters File
- Read Parameters from Drive
- Write Parameters to Drive
- Monitor Parameters
- Monitor Using Keypad
- Monitor Status
- Monitor Speed Reference
- Trend
- Remove Trend File
- Export Trend File
- Trace Function
- Remove Trace File
- Export Trace File
7.2.1 Identify Drive

**ACCESS**

Toolbar: ![Drive Identification Icon]
Menu: Drive > Identify Drive
Shortcut Key: none

**FUNCTION**

Automatic identification of the drive (drive must be connected to computer) or user select the drive manually.

**APPEARANCE**

![Identify Drive Window]

**DESCRIPTION**

**Drive Type**

If no drive is configured, it shows the address and "No Drive Configured" message.

If any drive is configured, the following information is displayed:

- Address.
- Type.
- Firmware version.
- Nominal voltage.
- Nominal current.

Remove button: clears the Drive Type field (remove the drive configuration).

**Automatic Identification**
- **Connection Type: USB** => When USB is selected in Communication Setup window,
- **Connection Type: Serial** => When Serial is selected in Communication Setup window,
- **Connection Type: Bluetooth** => When Bluetooth is selected in Communication Setup window,
- **Connection Type: Ethernet** => When Ethernet is selected in Communication Setup window.

Scan button: scans for drives connected to the computer. If any drive is connected, configuration is presented. The scan is finished when a drive is identified.

Start from Address button: to select the initial address of the scan when the connection type is serial; for USB connection, this button is disabled.

**Manual Identification**
Drive Type Button: select the drive model, firmware version and nominal voltage / current.

Accessory Button: select the accessory when it exists; select accessory name and firmware version.

**General Buttons**

OK button: applies changes and closes the window.

Cancel button: discard all changes and closes the window.

**Selection - Drive Type**

The drive need not to be connected to the computer.

Example:

![Drive Type Selection](image)

7.2.2 Communication Setup

**ACCESS**

Toolbar: ![Drive > Communication Setup]

Menu: Drive > Communication Setup

Shortcut Key: none

**FUNCTION**

This dialog box allows you to configure the PC communication port to match the setting on the drive for proper communication.

**APPEARANCE**
DESCRIPTION

Select the connection type: USB, Serial, Bluetooth or Ethernet.

USB
For USB no adjustment is necessary.

Get Version Button: Click this button to read the version of USB driver installed on the microcomputer.

Installed Version Field: displays the version of USB driver installed on the microcomputer.

Recommended Version Field: displays the correct version of USB driver should be installed on the computer.

Note Field: displays a message indicating whether the USB driver installed is OK or not.

<table>
<thead>
<tr>
<th>Message on Note Field</th>
<th>User Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>USB driver Ok!</td>
<td>Nothing to do, USB driver correctly installed.</td>
</tr>
<tr>
<td>Reasons</td>
<td>Install the USB driver available in USB_Driver\USBIO folder where SuperDrive G2 is installed. To install: run setup.exe and follow the installation wizard.</td>
</tr>
<tr>
<td>- No drive (equipment) is connected to the PC</td>
<td></td>
</tr>
<tr>
<td>- Old USB driver</td>
<td></td>
</tr>
<tr>
<td>- No USB driver installed</td>
<td></td>
</tr>
</tbody>
</table>

The following timing settings are available for USB:

<table>
<thead>
<tr>
<th>Timing</th>
<th>Range</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Menus

<table>
<thead>
<tr>
<th>Field</th>
<th>Range</th>
<th>Default</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Delay</td>
<td>0 ... 20000</td>
<td>0</td>
<td>[0 ... 20000]</td>
</tr>
<tr>
<td>Response Delay</td>
<td>0 ... 20000</td>
<td>0</td>
<td>[0 ... 20000]</td>
</tr>
<tr>
<td>Time-out</td>
<td>100 ... 20000</td>
<td>500</td>
<td>[100 ... 20000]</td>
</tr>
</tbody>
</table>

For more details see Drive Parametrization.

Serial

For RS232 you need to adjust some values. The communication protocol is Modbus-RTU.

<table>
<thead>
<tr>
<th>Connection Type</th>
<th>Serial Port Settings</th>
<th>Range</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>RS232</td>
<td>Baud rate (bps)</td>
<td>4800, 9600, 19200, 38400 or 57600</td>
<td>9600</td>
</tr>
<tr>
<td></td>
<td>Data bits</td>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td></td>
<td>Stop bits</td>
<td>1 or 2</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>Parity</td>
<td>No Parity, Even or Odd</td>
<td>No Parity</td>
</tr>
</tbody>
</table>

In addition to the possibility of manual configuration of the fields, it is also possible to load factory default values of each drive.

The model is selected in the Equipment checkbox.
After the drive is selected, the fields are automatically defined.

The following timing settings are available for Serial:

<table>
<thead>
<tr>
<th>Timing</th>
<th>Range</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Delay (ms)</td>
<td>0 ... 20000</td>
<td>0</td>
</tr>
<tr>
<td>Response Delay (ms)</td>
<td>0 ... 20000</td>
<td>0</td>
</tr>
<tr>
<td>Time-out (ms)</td>
<td>100 ... 20000</td>
<td>500</td>
</tr>
</tbody>
</table>

For more details see Drive Parametrization.

**Bluetooth**

<table>
<thead>
<tr>
<th>Timing</th>
<th>Range</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Delay (ms)</td>
<td>0 ... 20000</td>
<td>0</td>
</tr>
<tr>
<td>Response Delay (ms)</td>
<td>0 ... 20000</td>
<td>50</td>
</tr>
<tr>
<td>Time-out (ms)</td>
<td>100 ... 20000</td>
<td>500</td>
</tr>
</tbody>
</table>

Note: For the proper operation of the CFW100 inverter with the CFW 100-CBLT module, parameters P310, P311 and P312 must be set with the factory default values.

For further details refer to the CFW100 programming manual version V2.0K or above.
It may be necessary to increase the response delay to avoid communication errors.

**Ethernet**

Set the fields as indicated below.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
<th>Default</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Address</td>
<td>192.168.0.10</td>
<td>192.168.0.10</td>
<td>XXXX.XXXX.XXXX.XXXX</td>
</tr>
<tr>
<td>Port</td>
<td>502</td>
<td>502</td>
<td>1 ... 55535</td>
</tr>
<tr>
<td>Unit ID</td>
<td>255</td>
<td>255</td>
<td>1 ... 255</td>
</tr>
</tbody>
</table>

Use these values for communication with WEG drives.

**Buttons**

OK: applies changes and closes the window.
Cancel: discard all changes and closes the window.
7.2.3 Security System

ACCESS

Toolbar:
Menu: Drive > Security System
Shortcut Key: none

FUNCTION

The Security System allows you to configure a password to lock online parameters edition during a communication between PC and the drive. The offline activities and/or the execution of commands are not locked by Security System.

DESCRIPTION

The Security System - when available - allows to enable, disable or change current drive's password. These operations are done in online mode.

SuperDrive G2 shows a message alerting the user if current drive does not have Security System capabilities.

WARNING!

Define a strong password to the Security System. Use uppercase and lowercase letters and numbers intercalated.

Minimal requirement for password in SuperDrive G2 is one digit, but is strongly recommended to define a password with at least eight characters. Keep your password in a safe place.

[1] Presents the current Security System state. It could be: Enabled, Disabled or Communication Failure;
7.2.4 Security System (Session)

ACCESS

Toolbar:
Menu: Drive > Security System (Session)
Shortcut Key: none

FUNCTION

The Security System (Session) allows you to temporarily unlock online parameters edition during a communication between PC and the drive. By this option, it is not necessary to disable permanently the Security System. So, when the current project is closed the Security System is automatically enabled, locking the online parameters edition.

DESCRIPTION

The Security System (Session) - when available - allows to online parameters editing. This operation is done in online mode.

SuperDrive G2 shows a message alerting the user if current drive does not have Security System capabilities.

To allow the temporary online parameters edition it is mandatory you inform the password which is stored in drive.

This option is only available if the drive (which is connected to PC) already have a password to the Security System.

To access any functionality with access to edit a parameter, SuperDrive G2 asks if the user wants to allow the temporary online edition of parameters. The answer to this question keeps in SuperDrive G2 until the current project is closed.

To lock the temporary online edition of parameters just close the current project, or click over the icon - it corresponds to the Security System (Session) - and confirm the locking of online parameters edition in the confirmation message.

7.2.5 New Parameters File

ACCESS

Toolbar:
Menu: Drive > New Parameters File
Shortcut Key: none
**FUNCTION**

Creates a new parameters file with factory setting.

**DESCRIPTION**

If the project does not exist, a project name is requested to save. If the project already exists, a parameters file name is requested.

**Buttons**

Save: saves the parameters file and closes window.

Cancel: discard all changes and closes the window.

The filename must be specified by user and it is created with factory setting.

The file created is shown in Project Window (list of drive files).

This new file can be changed using Edit Parameters File.

---

**7.2.6 Edit Parameters File**

**ACCESS**

Toolbar:  
Menu: Drive > Edit Parameters File
Shortcut Key: none

**FUNCTION**

It opens a parameters file previously saved. It allows viewing and changing the parameters in the offline editor.

**PRESENTATION**

The user must select a file name in the Project Window and double-click on the file name or press Edit Parameters File.

The program will display a general view of all available parameters in a separate window. To edit a parameter, double-click on the user setting of the parameter that you wish to edit.

The following fields are available:

- Parameter number.
- Function.
- Minimum value.
- Maximum value.
- Factory setting.
- User's setting.
Menus

- Unit.

When the parameter is read-only, the user's setting field is disabled (it cannot be edited).

The user types the parameter value and presses Enter. Only values between minimum and maximum are allowed.

Some parameters present a simple list of values in a single column. The user can select entries from the list with the mouse. Only an item at a time can be selected.

The user can search information in the parameter table by informing the text or value to be searched and clicking on Find Next. When checking the option Match entire cell contents, the system searches for events where the entire cell content is equal to the searched term.

Buttons

Close: applies the changes if the user selects Yes and closes the window.

Log Panel

01

When the parameter file was generated by the project converter (see Convert Project), a message informs that the user must review the parameters as follows.

02

In this case, there is a simplified log file and a full log file available associated to the parameter file.

In the window, a panel (Project Conversion Log) appears with 2 buttons.

- Button : shows the simplified conversion log.
- Button : shows the full conversion log.
When exiting the window, the system asks the user if the parameters review has been completed.

- Yes: the system does not inform or ask about the parameter review anymore.
- No: the system keeps informing or asking about the parameter review.

### 7.2.7 Remove Parameters File

**ACCESS**

**Toolbar:**

**Menu:** Drive > Remove Parameters File

**Shortcut Key:** none
FUNCTION
Removes the parameters file.

APPEARANCE

DESCRIPTION
User must select a filename in the Project Window.
SuperDrive G2 will ask the user to confirm deleting the file.

7.2.8  Export Parameters File

ACCESS
Toolbar:  
Menu: Drive > Export Parameters File  
Shortcut Key: none

FUNCTION
Exports the content of a parameters file to another file in CSV format.

DESCRIPTION
User must select a parameters file name in Project Window.
SuperDrive G2 requests user to confirm the file export. In affirmative case, a window is shown with the following options:
Field delimiter. Options: semicolon or comma.
Field separator. Options: single quotes, double quotes or without quotes.
The name of the new file, in CSV format.
Buttons to export and to cancel the export.

7.2.9 Read Parameters from Drive

ACCESS

Toolbar: 
Menu: Drive > Read Parameters from Drive
Shortcut Key: none

FUNCTION

It reads all the parameters from the drive to the computer.

APPEARANCE
DESCRIPTION

All the parameters are saved in a computer file.

The user specifies the file name.

Then the user can view or edit the parameters.

Parameters File Generated By the Project Converter

If the parameters file was generated by the project converter, it is not possible to overwrite the file by reading the parameters from the drive.

An error message appears.

It is only possible to overwrite this file after the parameters review (Edit Parameters File function).

7.2.10 Write Parameters to Drive

ACCESS

Toolbar: ""  
Menu: Drive > Write Parameters to Drive  
Shortcut Key: none

FUNCTION

It sends all the parameters from the computer to the drive.
DESCRIPTION

The user must select a file name in the Project Window.

Some parameters can only be changed when the drive is disabled (motor stopped).

Serial

Select the drive address to which you want to send the parameters.

Press the OK button to start.

USB / Bluetooth / Ethernet

To start writing all parameters, the user must answer Yes to confirm the action.

Parameters File Generated By the Project Converter

If the parameters file was generated by the project converter, it is not possible to write the parameters to the drive.

An error message appears.
It is only possible to send the parameters to the drive after the parameters review (Edit Parameters File function).

**Parameter Writing Sequence (All Drives Except for CFW500 / CFW501 / MW500)**

The parameters are sequentially written from the first to the last parameter (from the lowest to the highest number).

At the end, a message pops up.

An error log may pop up in case some writing error occurs.
Parameter Writing Sequence (CFW500 / CFW501 / MW500)

The parameters are sequentially written from the first to the last parameter (from the lowest to the highest number) except for P312.

Parameter P312 (Serial Protocol) is only written at the end of the writing process.

Thus, in case of a writing error in a parameter, P312 is not written at the end of the writing process, and the user can send the parameters to the drive again.
On the other hand, if the parameters were all successfully written, then P312 is also sent to the drive.

An error log may pop up in case some writing error occurs.

7.2.11 Monitor Parameters

ACCESS

Toolbar:
Menu: Drive > Monitor Parameters
Shortcut Key: none
FUNCTION

Monitors all parameters in a grid. Allows to view and change the parameters in the online editor.

APPEARANCE

The program will show an overview of all the available parameters in a separate window. When SuperDrive G2 is online with a drive, it will show information from the drive being monitored. To edit a parameter double click on the parameter's user setting you would like to edit.

The following fields are available:

- Parameter number;
- Function;
- Minimum value;
- Maximum value;
- Factory setting;
- User's setting;
- Unit;
- Comparison.

When the parameter is read-only, the user's setting field is disabled (it can't be edited).

The user types the parameter value and press Enter. Only values between minimum and maximum are allowed.
In the online mode, to save the parameters in a file it is necessary confirming the action when the window is closed.

Some parameters shows a simple list of values in a single column. The user can select list entries with the mouse. Only one item can be selected at a time. When the user selects an item, any previously selected item is deselected first.

The user also can search for information in the parameter table typing the text or value to search and clicking on **Find Next**. By checking the **Match entire cell contents** option, the system searches for instances where the contents of the entire cell are equal to the search term.

### 7.2.12 Monitor using Keypad

**ACCESS**

Toolbar: ![Keypad Access Icon]
Menu: Drive > Monitor using Keypad
Shortcut Key: none

**FUNCTION**

Monitors one parameter and sends commands to the drive.

**APPEARANCE**

![Keypad Appearance Image]

**DESCRIPTION**

The following information related to the parameter are shown:
• Parameter number.
• Function.
• User's setting.
• Unit.

The user can view/change one parameter at a time.

Besides the parameters number there is a pair of tiny arrow buttons that let the user select the parameter number from an ordered sequence.

When the parameter is read-only, the user can't change the parameter value.

When the parameter can be changed, a button is available for changing the parameter's user setting.

Clicking on this button opens a new window where the user can change the parameter's user setting and press the Send button. Only values between minimum and maximum are allowed.

Some parameters shows a simple list of values in a single column. The user can select list entries with the mouse. Only one item can be selected at a time.

The drive commands window has buttons as described below.

**Command Buttons**

• Jog.
• Direction of rotation (forward/reverse).
• Local/Remote.
• Start.
• Stop.
• General Enable.
• General Disable.
• Reset.

To use these command buttons in SuperDrive G2, some parameters must be programmed to the serial/USB option:

• CFW-11 / CFW700 / CFW701 / CFW500 / CFW501 / MW500 - P0220...P0228;
• CFW100 - P220, P222, P226...P228;
• SSW-06 / SSW-07 / SSW-08 / SSW7000 - P220, P229, P230.

### 7.2.13 Monitor Status

**ACCESS**

Toolbar: ![Menu: Drive > Monitor Status](image)

Menu: Drive > Monitor Status
Shortcut Key: none

**FUNCTION**

Shows the status of the drive.
DESCRIPTION

The drive status window has indicators as described below.

CFW-11 / CFW-11M G2 Status

- Drive Status;
- Direction of Rotation: Forward/Reverse;
- Local/Remote;
- General Enable;
- Ramp Enable;
- Jog.

CFW-11RB Status

- Drive Status;
- General Enable;
- Ramp Enable.

CFW700 / CFW701 Status

- Drive Status;
- Direction of Rotation: Forward/Reverse;
- Local/Remote;
- General Enable;
- Ramp Enable;
- Jog.
CFW500 / CFW501 / MW500 Status

- Drive Status;
- Direction of Rotation: Forward/Reverse;
- Local/Remote;
- General Enabled;
- Motor running;
- Jog;
- Configuration Mode;
- Alarm;
- Fault.

CFW100 Status

- Drive Status;
- Direction of Rotation: Forward/Reverse;
- Local/Remote;
- General Enabled;
- Motor running;
- Jog;
- Configuration Mode;
- Alarm;
- Fault.

ECW500 Status

- Drive Status;
- State of Limiters;
- State of Digital Inputs;
- Events.
Status do CTW900

- Drive Status;
- Accelerating;
- Decelerating;
- Jog;
- Blocked;
- Configuration Mode;
- Auto-Ajuste;
- Segunda Rampa;
- Local/Remoto;
- Horário/Anti-horário;
- Invertendo;
- Subtensão;
- Alarme;
Menus

- Falha;
- Dis;
- DOs.

SSW-06 / SSW-07 / SSW-08 Status

- Drive Status;
- Direction of Rotation: Forward/Reverse;
- Local/Remote;
- General Enable;
- Motor Running;
- Jog;
- Accelerating;
- Current Limit;
- Full Voltage;
- Decelerating;
- Braking;
- Reverting;
- Main Power On;
- Bypass.
SSW7000 Status

- Drive Status;
- Direction of Rotation: Forward/Reverse;
- Local/Remote;
- General Enable;
- Motor Running;
- Jog;
- Accelerating;
- Full Voltage;
- Bypass;
- Decelerating;
- Braking;
- Reverting;
- Delay P0831;
- Main Power On;
- Configuration Mode;
- Alarm;
- Fault.

### 7.2.14 Monitor Speed Reference

**ACCESS**

Toolbar: ![Monitor Speed Reference Icon]
Menu: Drive > Monitor Speed Reference
Shortcut Key: none

**FUNCTION**

Shows the speed reference of the drive.

**APPEARANCE**

![Monitor Speed Reference Window]

**DESCRIPTION**

There are 6 fields which show data related to speed reference:

- Speed Reference - RPM or 13 bits
- Parameter
Menus

- User Setting
- Minimum
- Maximum
- New User Setting

The user can type a new value in New User Setting field and press Send button. Only values between minimum and maximum value are allowed.

The new value will appear in User Setting field after the drive has changed the value.

7.2.15 Trend

ACCESS

Toolbar: 📊
Menu: Drive > Trend
Shortcut Key: none

FUNCTION

Captures signal values from drives and displays it as a graph. Data can also be saved, printed and exported.

Up to ten drive signals can be monitored.

The Trend is for low to medium sampling rates.

APPEARANCE
DESCRIPTION

The following items are presented below:

- Configuring Trend,
- Acquiring Trend Data,
- Viewing Trends,
- Export Trends,
- Print Trends,
- Disk Usage.

Configuring Trend

Adding Channels

To add a channel, choose Add Channel.

In the Add Channel dialog box, enter the channel information. Use the drop down list to select the channel variable.
Once the channel is added to the trend, the range (upper and lower limits of Y-axis) and other properties related can be set.

To set the channel range and other properties:

1. Select the desired channel,
2. Set the maximum and minimum limits of the Y-axis labels and change the color of the line used to draw the signal.

To hide channels in the trend:

1. Select the desired channel,
2. Uncheck the visibility property.

**NOTE!**
To redisplay hidden channels, check the visibility property again.

Removing Channels

To remove a channel from the trend

1. Select the desired channel,
2. Choose Remove Channel.

Configuring the Time Axis

The range of the time (horizontal axis) visible on the graph can be changed by using the Trend Time Axis drop down list.

The time axis requires a range in seconds.
Selecting the Sampling Rate

Adjust the sampling period when needed.

The sampling period requires a value in milliseconds, between 200 ms (0.2 s) and 86,400,000 ms (24h).

This is the period of time until next channels be acquired.

Check the box to calculate continuously the faster sampling rate.

This sampling rate may vary according to communication type between drive and PC and the amount of channels being acquired simultaneously.

When this option is enabled, data are read as fast as possible:

**NOTE!**

Enable **Continuous** option to read data from channels as fast as possible.

The minimum sampling period can vary according to the number of channels, communications’ baud rate, etc.

While capturing, the Trend displays the values of the channels.

In an ideal condition, these are the minimal sampling rate for each communication type:
- USB: at least 150 ms. Add 50 ms for each channel being observed.
- Serial: at least 150 ms. Add 50 ms for each channel being observed.
- Bluetooth: at least 350 ms. Add 300 ms for each channel being observed.

To monitor for a long period of time, use a high sampling interval.

Otherwise, the amount of points being constantly processed should cause slowdowns and instability during the graphic presentation.

Use the equation below to estimate the amount of points in the graphic.

\[
\text{Amount of Points} = \frac{\text{Channels Quantity} \times \text{Time of Acquisition (s)} \times \text{Sampling Rate (ms)}}{1000}
\]
Results over than 20,000 points may cause slowdowns and instability:

**Opening Graph**

A dialog box prompts you to view the graph:

![Graph opening dialog box](image)

Message while updating chart on screen:

![Updating chart dialog box](image)

---

### Acquiring Trend Data

**Capturing and Saving Trends**

After channels were added to Trend, you must start capturing to view the trend on the graph.

There are four options available: **Start, Pause, Stop** and **Save**.

The options **Start, Pause** and **Stop** requires communication with drive.

- **Start Button**: Press **Start** button to start trending.
- **Pause Button**: Click **Pause** when is necessary analysing data during the acquisition.

While it is enabled, the acquisition still running but the last data read are not shown in the graph.

To scroll Trend, choose **Pause**. Clicking over the graphic will show up the scroll bar (only if there is part of the graphic not shown in the visible area).

When **Pause** is deselected, the graphic shows last data being acquired.

- **Stop Button**: Press **Stop** to stop trending of the selected signals. The acquired data are not save yet.
- **Save Button**: Press **Save** to store the acquired data.

SuperDrive G2 offers an option to save a trend for later analysis without a drive connected.
The files have the extension .trend.

A dialog box is shown. Type the filename and click Save:

![Save dialog box](image)

**NOTE!**
While data is being acquired, Trend shows last channels’s data in graphic.
When the graphic is scrolled during the data acquisition, it stops showing the last data read.
To revert it, is necessary to Restore Width (it is placed above the graphic).

---

**Viewing Trends**

To open a previously saved trend, select the file with the .trend extension in the Project Window and then choose menu Drive > Trend.

It is not necessary to have the drive connected while viewing previously saved trends.

You can move through the samples using the scroll bar to examine data in detail.

**Using the Cursor**

To activate this marker press the left mouse button over the graph area.

The marker can be moved by clicking the mouse over the trend screen.

The selected sample time and value of each channel are indicated.
**Zoom**

You can zoom in and zoom out of the trend.

To zoom in on the trend, choose + or **Zoom** and place the mouse pointer at the top left corner of the area you want to zoom in.

Click and hold the left mouse button then drag the pointer to draw a rectangle and release the mouse button.

The view of the trend zooms in.

To zoom out of the trend, choose -. The view of the trend zooms out. Horizontal Zoom Out stops when the width reaches its original value.

**Scroll (Pan)**

You can scroll the trend using the mouse.

To scroll Trend, choose **Pan**.

Click and hold the left mouse button at the graph area then drag the pointer to move graph in direction the mouse is moved.

---

**Export Trends**

The currently displayed trend can be exported to a PNG file.

To export a trend:

1. Open the trend you want to export,
2. Choose **Export**,
3. Enter a filename for the PNG file.

---

**NOTE!**

To export the data acquired, go on **Export Trend File**.

---

**Print Trends**
The currently displayed trend can be printed.

To print a trend:

1. Open the trend you want to print,
2. Choose Print.

**NOTE!**
When printing or exporting, it is recommended to set the legend visible.

### Disk Usage

Trend creates temporary files during data acquiring. These information are needed to estimate how much disk space will be required for trend files:

- Number of channels,
- Time interval (total in s),
- Sampling rate (in ms).

Use the equation below to estimate necessary amount of free disk space:

\[
\text{Disk Space} = \frac{\text{Number of Channels} \times \text{Time Interval (s)} \times 25}{\text{Sampling Rate (ms)} / 1000}
\]

### Examples

**Case 1**

Monitor 5 channels during 100 s (1:40:00) at 200 ms sampling rate:

\[
\text{Disk Space} = \frac{5 \times 100 \times 25}{200 / 1000} = 62 \text{ Kb}
\]

**Case 2**

Monitor 10 channels during 14400 s (4:00:00) at 500 ms sampling rate:

\[
\text{Disk Space} = \frac{10 \times 14400 \times 25}{500 / 1000} = 7 \text{ Mb}
\]

**Case 3**

Monitor 4 channels during 2592000 s (30 days) at 500 ms sampling rate:

\[
\text{Disk Space} = \frac{4 \times 2592000 \times 25}{500 / 1000} = 518 \text{ Mb}
\]
Case 4

Monitor 2 channels during 864000 s (10 days) at 2000 ms sampling rate:

\[
\text{Disk Space} = \frac{2 \times 864000 \times 25}{2000} = 21 \text{ Mb}
\]

7.2.16 Remove Trend File

**ACCESS**

Toolbar: 
Menu: Drive > Remove Trend File
Shortcut Key: none

**FUNCTION**

Remove all trend files.

**DESCRIPTION**

User must select a filename in the Project Window.

SuperDrive G2 will ask the user to confirm deleting all trend files.

7.2.17 Export Trend File

**ACCESS**

Toolbar: 
Menu: Drive > Export Trend File
Shortcut Key: none

**FUNCTION**

Exports the content of a trend file to another file in CSV format.

**DESCRIPTION**

User must select a trend file name in the project tree.

SuperDrive G2 requests user to confirm the file export.

In affirmative case, a window is shown with the following options:
Field delimiter. Options: semicolon or comma.
Field separator. Options: single quotes, double quotes or without quotes.
The name of the new file, in CSV format.
Buttons to export and to cancel the export.

7.2.18 Trace

ACCESS

Toolbar:
Menu: Drive > Trace
Shortcut Key: none

FUNCTION

It presents a graph of acquired trace function’s data.

APPEARANCE
DESCRIPTION

The window presents a graph of trace channel's data for the selected file. If no file is selected, a blank graph is presented.

Press the button Config Trace to configure the trace function.

Trace Function Configuration

A window with trace configuration parameters is presented. Use the editable fields to change parameters contents. The editable fields have the factory default value (if no file was selected), or the values from the previously saved file.

- Read configuration - to read the trace configuration parameters from the drive. The parameters settings will be read from the drive and presented in the window.
- Write configuration - to send the trace configuration to the drive. The configuration parameters are sent to the drive.
- Start Trace - used to start the trace function on the drive. The start trace command is sent to the drive.
- Close - to close the configuration window.
- Acquire data - to acquire trace function data.

Trace Function Acquisition
If the trace function status is not complete, the trace function status monitor window is presented.

While the status is not complete, the button OK is disabled and the acquisition can not be performed.

When the status is complete, all programmed trace channel's data is acquired.

When the acquisition is complete please type the file name where all trace information and channel's data is to be stored.

### Graph Visualization

Trace channel's data is presented in a graph. The channel information table is presented below the graph.

- # - trace channel's index.
- Visible - shows/changes channel's visibility in the graph.
- Color - shows/changes the color which represents channel's data in the graph.
- Description - trace channel's acquired variable description.
- Sample time - time of the selected sample in the chart.
- Sample value - value of the selected sample in the chart.
- Unit - trace channel's data unit.
- Minimum - shows/changes the lower bound for the axis of this channel in the graph.
- Maximum - shows/changes the upper bound for the axis of this channel in the graph.

A black vertical line is shown at the trigger position. At the top of the graph is the trigger description.

### Graph Manipulation

It is possible to change the sample cursor position by clicking at the graph. A toolbar with the following options can be found above the graph:

- Export: exports the graph area as a PNG image.
- Print: prints the graph area.
- Pan: changes to Pan Mode.
- Zoom: changes to Zoom Mode.
- Zoom +: magnifies the graph area.
- Zoom -: zoom out the graph area.
- Restore width: restores the initial width of the horizontal axis.
- Restore height: restores the initial height of the vertical axis.
- Auto height: automatic height depending on the maximum or minimum values of the samples.
- Legend: shows/hide the graph legend.
Pan Mode

In Pan Mode press the mouse button over the graph area and drag to move the graph in the desired direction.

Zoom Mode

In Zoom Mode press the mouse button over the graph area and drag to draw a zoom box. Release the mouse button to magnify the selected graph area.

7.2.19 Remove Trace File

ACCESS

Toolbar: 
Menu: Drive > Remove Trace File
Shortcut Key: none

FUNCTION

Remove all trace files.

DESCRIPTION

User must select a filename in the Project Window.
SuperDrive G2 will ask the user to confirm deleting all trace files.

7.2.20 Export Trace File

ACCESS

Toolbar: 
Menu: Drive > Export Trace File
Shortcut Key: none

FUNCTION

Exports the content of a trace file to another file in CSV format.

DESCRIPTION

User must select a trace file name in the project tree.
SuperDrive G2 requests user to confirm the file export.
In affirmative case, a window is shown with the following options:

- Field delimiter. Options: semicolon or comma.
- Field separator. Options: single quotes, double quotes or without quotes.
- The name of the new file, in CSV format.
- Buttons to export and to cancel the export.

7.3 Tools

Options
Import Database
Convert Project
Simplified Conversion Log
Remove Simplified Conversion Log
Full Conversion Log
Remove Simplified Conversion Log

7.3.1 Options

ACCESS

Toolbar: none
Menu: Tools > Options
Shortcut Key: none
FUNCTION

Allows the user to select options for SuperDrive G2.

PRESENTATION

![Options menu]

DESCRIPTION

The options are available via tabbed menu. To access them, click over the tab name:

- Language
- Print
- Projects

Language

Allows the user to select a language.

Three languages are available:

- English,
- Spanish,
- German,
- Portuguese.

Besides the language selection of the software, the user can change the priority language selection of alternative database, which occurs when the selected drive does not have support for the selected language.

When successfully applies a language change, system presents a confirmation message.
Menus

Print

Allows the user to select the parameters printing options.

Four options are available:

- Print all parameters;
- Print all parameters, highlight changes in bold font (when compared to standard values);
- Print all parameters, highlight changes in red font (when compared to standard values);
- Print changed parameters only (when compared to standard values).

Projects

Allows the user to select the main projects folder, when SuperDrive G2 projects are stored.
This option presents the current main projects folder, where is possible to change this path:
You must close the project before accessing this function. Otherwise, while a project is open
SuperDrive G2 disables this option.

[1] Current path and folder where projects are stored.
[2] New path where projects will be stored. This field only updates after you choose a new
path throws items [3] or [4].
[3] When selecting this option, the system restores the standard path and folder where
projects will be stored.
[4] This button selects a new path where projects will be stored.
[5] This button apply the changes. It will be available only if there were changes.
7.3.2 Import Database

ACCESS

Toolbar: Tools > Import Database
Menu: Tools > Import Database
Shortcut Key: none

FUNCTION

Allows the user to import or update databases for SuperDrive G2.

DESCRIPTION

User must select a Database Package file.
The information of the selected Database Package is displayed in the Import Database window.

NOTE!
Ensure there is no project open before access this function.

7.3.3 Convert Project

ACCESS

Toolbar: Tools > Convert Project
Menu: Tools > Convert Project
Shortcut Key: none

FUNCTION

This function allows converting a project from one firmware version to another firmware version.

PRESENTATION
The project conversion window, shown above, has 10 panels, which are presented in a simplified way below:

<table>
<thead>
<tr>
<th>Description</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Original Project</td>
<td>Target Project</td>
</tr>
<tr>
<td>Original Drive</td>
<td>Target Drive</td>
</tr>
<tr>
<td>Original Accessory</td>
<td>Target Accessory</td>
</tr>
<tr>
<td>Convert Project</td>
<td>Result after the Conversion</td>
</tr>
</tbody>
</table>

Each panel has the following information:

- **Description**: brief description of the convert project function.
- **Steps**: indicate the fields to be changed/selected, and the button to start the project conversion.
- **Original Project**: source project name, as well as its path.
- **Target Project**: target project name, as well as its path.
- **Original Drive**: model, firmware version and voltage/rated current.
- **Target Drive**: model, firmware version and voltage/rated current.
- **Original Accessory**: source accessory name and firmware version, when available.
- **Target Accessory**: target accessory name and firmware version, when available.
- **Convert Project**: button to start the project conversion; this button is enabled under certain conditions.
- **Result after the Conversion**: presents a progress bar during the project conversion, showing a success or error status at the end of the conversion; 2 buttons are available: simplified conversion log and full conversion log.

**DESCRIPTION**
It is possible to select the firmware version, rated voltage and current in the target project. Accessory, when available, can also be selected.

A new project will be created.

Source project will not be modified.

**Checkbox - Show the fields to fill in/select and button to start conversion**

The user can click on the checkbox to highlight the fields (orange) which must be modified before starting the project conversion.

---

### How to Convert the Projects

1. **01** - Fill in the name of the target project.

2. **02** - Select the firmware version, rated voltage and rated current of the target drive.

3. **03** - Select the accessory and firmware version, when available.

4. **04** - Click on the button to start the project conversion.

5. **05** - Click Yes to start the project conversion.
06 - Wait for the process to finish.

07 - Select one of the presented options.

- Simplified Conversion Log: opens the simplified conversion log viewer.
- Full Conversion Log: opens the full conversion log viewer.
- No: return to the project conversion window.

08 - It returns to the project conversion window after closing the log viewer.

It is possible to view the conversion log.

2 buttons are available:

- Simplified Conversion Log: opens the simplified conversion log viewer.
- Full Conversion Log: opens the full conversion log viewer.
09 - Exit the Project Conversion Window.

When exiting the window, after the successful project conversion, the system asks if the user wants to open the new project that has been generated.

- Yes: closes the original project and opens the new created project.
- No: returns to the main window of the SuperDrive G2, keeping the source project open.

**Review of the Parameters Generated in the Target Project**

In the Convert Project panel, a **warning message** tells the user to check all the parameters after conversion.

Therefore, the user must open the target project and review the content of the parameters in the **offline parameter editor**, changing the content if necessary.

In the parameter editor, after the edition, the system asks the user if the review is complete (yes or no).

It is necessary to review the parameters in order to be able to send the converted parameters to the drive or to read the parameters and overwrite the converted parameters.
If the parameters are not reviewed, the system will allow neither reading nor writing the converted parameters.

Conversion Log

The (simplified or full) conversion log can then be viewed. See the chapters:

- Simplified Conversion Log.
- Full Conversion Log.

Rules Used in the Project Conversion

01
- Reason: Parameter in the source project does not exist in the target project
- Action: Non-existent parameter in the target project

02
- Reason: Target parameter is read-only
- Action: Factory setting of the target parameter assumed

03
- Reason: Content of the source parameter is equal to the factory setting
- Action: Factory setting of the target parameter assumed

04
- Reason: Source parameter content is between the maximum and minimum of the target parameter
- Action: Source parameter content is copied to the target parameter content

05
- Reason: Source parameter content is out of the limits of the target parameter
- Action: Factory setting of the target parameter assumed

06
- Reason: Target parameter is new (it does not exist in the source project)
- Action: Factory setting of the target parameter assumed

7.3.4 Simplified Conversion Log

ACCESS

Toolbar: 
Menu: Tools > Simplified Conversion Log
Shortcut Key: none

FUNCTION

It displays the simplified conversion log, generated by the convert project function.

This log includes the parameter conversions, but only new parameters or parameters whose content has been changed in the target project.
PRESENTATION

The log viewer shows the log where it is possible to view from the beginning to the end, with a horizontal and vertical scroll bar.

- Print Button: sends the log to the current printer.
- Close Button: closes the window.

DESCRIPTION

The log viewer shows the log where it is possible to view from the beginning to the end, with a horizontal and vertical scroll bar.

- Print Button: sends the log to the current printer.
- Close Button: closes the window.

Simplified Conversion Log Content

The log has the following information:

- Date.
- Time.
- Original project name, including the drive model, firmware version, rated voltage/current, firmware version/accessory.
- Target project name, including the drive model, firmware version, rated voltage/current, firmware version/accessory.
- Parameters file name.
- List of new/changed parameters, where each parameter presents: number, description, content, and applied action (only new parameters or the ones whose content has been changed by the project converter).
7.3.5 Remove Simplified Conversion Log

**ACCESS**

Toolbar: 
Menu: Tools > Remove Simplified Conversion Log 
Shortcut Key: none

**FUNCTION**

It removes the simplified conversion log.

**PRESENTATION**

![Image of Remove Simplified Conversion Log window]

**DESCRIPTION**

When clicking on the button or menu item **Remove Simplified Conversion Log**, a message prompts the confirmation to remove the file.

- Yes: removes the file.
- No: aborts the operation.

7.3.6 Full Conversion Log

**ACCESS**

Toolbar: 
Menu: Tools > Full Conversion Log 
Shortcut Key: none

**FUNCTION**

It displays the full conversion log, generated by the **Convert Project** function.

This log includes the conversions of all the parameters.

**PRESENTATION**
DESCRIPTION

The log viewer shows the log where it is possible to view from the beginning to the end, with a horizontal and vertical scroll bar.

- Print Button: sends the log to the current printer.
- Close Button: closes the window.

Full Conversion Log Content

The log has the following information:

- Date.
- Time.
- Original project name, including the drive model, firmware version, rated voltage/current, firmware version/accessory.
- Target project name, including the drive model, firmware version, rated voltage/current, firmware version/accessory.
- Parameters file name.
- List of all the parameters of the target project, where each parameter presents: number/description of the original project, number/description of the target project, original and target parameter content, reason and applied action.
7.3.7 Remove Full Conversion Log

ACCESS

Toolbar: Menu: Tools > Remove Full Conversion Log
Shortcut Key: none

FUNCTION

It removes the full conversion log.

PRESENTATION

When clicking on the button or menu item Remove Full Conversion Log, a message prompts the confirmation to remove the file.

- Yes: removes the file.
- No: aborts the operation.

7.4 Help

Contents
About

7.4.1 Contents

ACCESS

Toolbar: Menu: Help > Contents
Shortcut Key: none

FUNCTION

Opens the online help.
DESCRIPTION

A comprehensive online documentation is available. The documentation can be printed.

7.4.2 About

ACCESS

Toolbar: S
Menu: Help > About
Shortcut Key: none

FUNCTION

Displays information about SuperDrive G2 version, build, etc.

DESCRIPTION

Displays the following information:

- Software name.
- Version.
- Build.
- Launch date.
- Copyright.
- Simplified software description.
- Operational systems where the software can run.
- Java informations.
8 Communication

Contents of this chapter:

Drive Parametrization
USB Connection
USB Connection - Virtual COM Port
RS232 Connection
RS485 Connection
Bluetooth Connection
Ethernet Connection
RS232 Cable
USB Cable
Ethernet Cable
USB to Serial Adapter
Bluetooth USB Adapter
Ethernet Network Adapter

Before Trying to Establish Communication

Exception During Monitoring

8.1 Drive Parametrization

The following parameters must be set as below:

<table>
<thead>
<tr>
<th>Drive</th>
<th>Connection Type</th>
<th>Parameter</th>
<th>Description</th>
<th>Recommended</th>
</tr>
</thead>
<tbody>
<tr>
<td>CFW-11</td>
<td>Ethernet</td>
<td>0723</td>
<td>Anybus Identification</td>
<td>19 = EtherNet/IP or 21 = Modbus-TCP or 23 = PROFINET IO</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0841</td>
<td>Communication Rate</td>
<td>0 = Auto</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0842</td>
<td>Time-out Modbus TCP</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0843</td>
<td>IP Address Configuration</td>
<td>0 = Parameters</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0844</td>
<td>IP1 Address</td>
<td>192</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0845</td>
<td>IP2 Address</td>
<td>168</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0846</td>
<td>IP3 Address</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0847</td>
<td>IP4 Address</td>
<td>10</td>
</tr>
<tr>
<td>Drive</td>
<td>Connection Type</td>
<td>Parameter</td>
<td>Description</td>
<td>Recommended</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------</td>
<td>-----------</td>
<td>----------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>CFW-11</td>
<td>USB</td>
<td>0308</td>
<td>Serial Address</td>
<td>1</td>
</tr>
<tr>
<td>CFW-11RB</td>
<td>(WEG)</td>
<td>0308</td>
<td>Serial Address</td>
<td>1</td>
</tr>
<tr>
<td>CFW-11M G2</td>
<td></td>
<td>0308</td>
<td>Serial Address</td>
<td>1</td>
</tr>
<tr>
<td>CFW700</td>
<td>RS485</td>
<td>0308</td>
<td>Serial Address</td>
<td>1</td>
</tr>
<tr>
<td>CFW701</td>
<td></td>
<td>0308</td>
<td>Serial Address</td>
<td>1</td>
</tr>
<tr>
<td>CFW500</td>
<td>RS485</td>
<td>0308</td>
<td>Serial Address</td>
<td>1</td>
</tr>
<tr>
<td>CFW501</td>
<td></td>
<td>0308</td>
<td>Serial Address</td>
<td>1</td>
</tr>
<tr>
<td>CFW500</td>
<td>USB (Virtual</td>
<td>0308</td>
<td>Serial Address</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>COM Port) (FTDI)</td>
<td>0308</td>
<td>Serial Address</td>
<td>1</td>
</tr>
<tr>
<td>MW500</td>
<td>RS232</td>
<td>0308</td>
<td>Serial Address</td>
<td>1</td>
</tr>
<tr>
<td>MW500</td>
<td>RS485</td>
<td>0308</td>
<td>Serial Address</td>
<td>1</td>
</tr>
<tr>
<td>Drive</td>
<td>Connection Type</td>
<td>Parameter</td>
<td>Description</td>
<td>Recommended</td>
</tr>
<tr>
<td>-----------</td>
<td>-----------------</td>
<td>-----------</td>
<td>--------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>USB (Virtual COM Port)</td>
<td>0312</td>
<td>Serial Protocol</td>
<td>2 = Modbus RTU (1) [with plug-in module CFW500-CUSB]</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>6 = HMIR (1) + Modbus RTU (2) [with plug-in module CFW500-CUSB, CFW500-CRS232 or CFW500-CRS485]</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>USB (Virtual COM Port) (FTDI)</td>
<td>0312</td>
<td>Serial Protocol</td>
<td>2 = Modbus RTU (1) [with plug-in module CFW500-CUSB]</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>6 = HMIR (1) + Modbus RTU (2) [with plug-in module CFW500-CUSB, CFW500-CRS232 or CFW500-CRS485]</td>
</tr>
<tr>
<td></td>
<td>Bluetooth</td>
<td>0770</td>
<td>Bluetooth Device Name</td>
<td>Random number</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0771</td>
<td>Bluetooth PIN</td>
<td>1234</td>
</tr>
<tr>
<td>CFW100</td>
<td>USB</td>
<td>0308</td>
<td>Serial Address</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0310</td>
<td>Serial Baud Rate</td>
<td>1 = 19200 bits/s</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0311</td>
<td>Serial Bytes Config.</td>
<td>1 = 8 bits, even parity, 1sb</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0312</td>
<td>Serial Protocol</td>
<td>2 = Modbus RTU</td>
</tr>
<tr>
<td></td>
<td>RS485</td>
<td>0308</td>
<td>Serial Address</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0310</td>
<td>Serial Baud Rate</td>
<td>1 = 19200 bits/s</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0311</td>
<td>Serial Bytes Config.</td>
<td>1 = 8 bits, even parity, 1sb</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0312</td>
<td>Serial Protocol</td>
<td>2 = Modbus RTU</td>
</tr>
<tr>
<td></td>
<td>USB (Virtual COM Port)</td>
<td>0308</td>
<td>Serial Address</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0310</td>
<td>Serial Baud Rate</td>
<td>1 = 19200 bits/s</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0311</td>
<td>Serial Bytes Config.</td>
<td>1 = 8 bits, even parity, 1sb</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0312</td>
<td>Serial Protocol</td>
<td>2 = Modbus RTU</td>
</tr>
<tr>
<td></td>
<td>Bluetooth</td>
<td>0770</td>
<td>Bluetooth Device Name</td>
<td>Random number</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0771</td>
<td>Bluetooth PIN</td>
<td>1234</td>
</tr>
<tr>
<td>CTW900</td>
<td>USB (WEG)</td>
<td>-----</td>
<td>-----</td>
<td>-----</td>
</tr>
<tr>
<td>ECW500</td>
<td>RS485</td>
<td>30006</td>
<td>Serial Baud Rate</td>
<td>2 = 38400 bits/s</td>
</tr>
<tr>
<td></td>
<td></td>
<td>30008</td>
<td>Serial Parity</td>
<td>0 = None</td>
</tr>
<tr>
<td></td>
<td></td>
<td>30010</td>
<td>Serial Stop Bits</td>
<td>1</td>
</tr>
<tr>
<td>SCA-06</td>
<td>USB (WEG)</td>
<td>-----</td>
<td>-----</td>
<td>-----</td>
</tr>
<tr>
<td></td>
<td>Ethernet</td>
<td>0800</td>
<td>Ethernet Module Identification</td>
<td>1 = Modbus TCP</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>or 2 = EtherNet/IP</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>or 3 = PROFINET IO</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0803</td>
<td>Ethernet Communication Rate</td>
<td>0 = Auto</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0806</td>
<td>Watchdog Modbus TCP</td>
<td>0.0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0810</td>
<td>IP Address Configuration</td>
<td>0 = Parameters</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0811</td>
<td>IP1 Address</td>
<td>192</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0812</td>
<td>IP2 Address</td>
<td>168</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0813</td>
<td>IP3 Address</td>
<td>0</td>
</tr>
</tbody>
</table>
### Communication

<table>
<thead>
<tr>
<th>Drive</th>
<th>Connection Type</th>
<th>Parameter</th>
<th>Description</th>
<th>Recommended</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>IP4 Address</td>
<td>10</td>
</tr>
<tr>
<td><strong>SSW-06</strong></td>
<td><strong>RS232</strong></td>
<td>308</td>
<td>SSW Address</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>USB (Virtual COM Port) (FTDI)</td>
<td>-----</td>
<td>-----</td>
<td>USB Communication Kit (K-USB) should be used, which is supplied with the product</td>
</tr>
<tr>
<td></td>
<td><strong>312</strong></td>
<td>Serial Protocol</td>
<td>1: MB 9600 N (Modbus-RTU 9600 bps, no parity), 8 bits, 2sb</td>
<td></td>
</tr>
<tr>
<td><strong>SSW-07</strong></td>
<td><strong>RS232</strong></td>
<td>308</td>
<td>SSW Address</td>
<td>1</td>
</tr>
<tr>
<td><strong>SSW-08</strong></td>
<td><strong>RS232</strong></td>
<td>312</td>
<td>Serial Protocol</td>
<td>1: MB 9600 N (Modbus-RTU 9600 bps, no parity), 8 bits, 2sb</td>
</tr>
<tr>
<td></td>
<td>USB (WEG)</td>
<td>-----</td>
<td>-----</td>
<td>-----</td>
</tr>
<tr>
<td><strong>SSW7000</strong></td>
<td><strong>USB</strong></td>
<td>308</td>
<td>Serial:Address</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>310</td>
<td>Serial:Bit Rate</td>
<td>1: 9600 bps</td>
</tr>
<tr>
<td></td>
<td></td>
<td>311</td>
<td>Serial:Data Con.</td>
<td>3: 8b, no parity, 2sb</td>
</tr>
<tr>
<td></td>
<td></td>
<td>312</td>
<td>Serial:Protocol</td>
<td>2: Modbus-RTU</td>
</tr>
</tbody>
</table>

**NOTE!**

Drive and SuperDrive G2 must use the same settings.
For CFW-09 PM, P308, P310 and P311 can be changed, see Frequency Inverter Manual - CFW-09 PM.
For CFW700, P0308, P0310 and P0311 can be changed, see Programming and Maintenance Manual - CFW700.
For SSW, P308 and P312 can be changed, see Serial Communication Manual.
(1) CFW500 - Port 1 - terminals 12, 14, 16.
(2) CFW500 - Port 2 - USB, DB9 or RS485 connector (terminals 20, 22, 24).

### 8.2 USB Connection

The drive should be located at a distance shorter than 3 m from the computer.

This connection is made with **USB Cable**, supplied with drive user's guide.

USB Driver: user must install the USB driver available at USB_Driver\USBIO folder.

**CFW-11 / CFW-11RB / CFW-11M G2**

Figure below shows how to connect a computer to the drive (USB).
WARNING!
Switch off the drive before making the connections.

1. The USB connector is in the front cover of the drive.
2. Connect the type B connector of USB cable to the USB connector of the drive.
3. Connect the type A connector of USB cable to the computer USB port.
4. Check if in the SuperDrive G2 Communication Setup the selected connection type is USB.

CTW900

WARNING!
Switch off the drive before making the connections.

1. The USB connector is in the front cover of the drive.
2. Connect the type B connector of USB cable to the USB connector of the drive.
3. Connect the type A connector of USB cable to the computer USB port.
4. Check if in the SuperDrive G2 Communication Setup the selected connection type is USB.

SCA-06

WARNING!
Switch off the drive before making the connections.

1. The USB connector is in the front cover of the drive.
2. Connect the type B connector of USB cable to the USB connector of the drive.
3. Connect the type A connector of USB cable to the computer USB port.
4. Check if in the SuperDrive G2 Communication Setup the selected connection type is USB.

SSW7000

WARNING!
Switch off the drive before making the connections.

1. The USB connector is in the front cover of the drive.
2. Connect the type B connector of USB cable to the USB connector of the drive.
3. Connect the type A connector of USB cable to the computer USB port.
4. Check if in the SuperDrive G2 Communication Setup the selected connection type is USB.

**CFW700 / CFW701**

Figure below shows how to connect a computer to the drive (USB).

![USB Connection Image]

**WARNING!**

Switch off the drive before making the connections.

This connection is available in CFW700’s HMI since S/N 1024003697.
This connection is available in CFW701’s HMI since S/N 1023801859.

1. The USB connector is in the drive’s HMI.
2. Connect the type mini-B connector of USB cable to the USB connector of the drive.
3. Connect the type A connector of USB cable to the computer USB port.
4. Check if in the SuperDrive G2 Communication Setup the selected connection type is USB.

**8.3 USB Connection - Virtual COM Port**

The drive should be located at a distance shorter than 3 m from the computer.

This connection is made with USB Cable, supplied with drive user’s guide.

USB Driver: user must install the USB driver available at USB_Driver\FTDI folder.

**SSW-06**

Figure below shows how to connect a computer to the drive (USB).
Device manager in Windows indicates which serial port is connected to the drive.
The computer name in device manager is purposely unreadable.

In SuperDrive G2, select the serial port correctly in Communication Setup window as follows.
WARNING!
Switch off the drive before making the connections.

1. Connect the mini-B connector of usb cable to the usb connector of the drive.
2. Connect the type A connector of usb cable to the computer usb port.
3. In device manager check which serial port is connected.
4. Check if in the SuperDrive G2 Communication Setup the selected connection type is serial.
5. The serial port in the window of communication setup window should be the same serial port that appears in the device manager, where the USB cable is connected.

CFW500 / CFW501

Figure below shows how to connect a computer to the drive (USB).
F0312 = 6 [HMI (1) + Modbus RTU (2)]
or
F0312 = 7 [Modbus RTU (2)]
Device manager in Windows indicates which serial port is connected to the drive. The computer name in device manager is purposely unreadable.

In SuperDrive G2, select the serial port correctly in Communication Setup window as follows.
WARNING!
Switch off the drive before making the connections.

1. Connect the mini-B connector of USB cable to the USB connector of the drive.
2. Connect the type A connector of USB cable to the computer USB port.
3. In device manager check which serial port is connected.
4. Check if in the SuperDrive G2 Communication Setup the selected connection type is serial.
5. The serial port in the window of communication setup window should be the same serial port that appears in the device manager, where the USB cable is connected.

CFW100

Figure below shows how to connect a computer to the drive (USB).
Device manager in Windows indicates which serial port is connected to the drive. The computer name in device manager is purposely unreadable.
In SuperDrive G2, select the serial port correctly in Communication Setup window as follows.
1. Connect the mini-B connector of usb cable to the usb connector of the drive.
2. Connect the type A connector of usb cable to the computer usb port.
3. In device manager check which serial port is connected.
4. Check if in the SuperDrive G2 Communication Setup the selected connection type is serial.
5. The serial port in the window of communication setup window should be the same serial port that appears in the device manager, where the USB cable is connected.
6. Never change values in P308, P310 and P312 during a connection. Changing these parameters instantly causes connection lost between PC and drive.

**MW500**

Figure below shows how to connect a computer to the drive (USB).

**WARNING!**

With the drive turned off, be sure that position 1 of DipSwitch S10 is OFF, as shown below:
Communication

P0312 = 2 [Modbus RTU (1)]
or
P0312 = 6 [HMI (1) and Modbus RTU (2)]
Device manager in Windows indicates which serial port is connected to the drive. The computer name in device manager is purposely unreadable.

In SuperDrive G2, select the serial port correctly in Communication Setup window as follows.
WARNING!
Switch off the drive before making the connections.

1. Connect the mini-B connector of usb cable to the usb connector of the drive.
2. Connect the type A connector of usb cable to the computer usb port.
3. In device manager check which serial port is connected.
4. Check if in the SuperDrive G2 Communication Setup the selected connection type is serial.
5. The serial port in the window of communication setup window should be the same serial port that appears in the device manager, where the USB cable is connected.

8.4 RS232 Connection

The RS-232 standard (Recommended Standard 232) is only used in peer-to-peer communication, that is, it accepts two devices for communication: one master and one slave.

The drive, which is the slave, must be located less than 10 meters away from the computer (master).

SSW-06

Figure below shows how to connect a computer to the drive (RS232 point-to-point).
Communication

1. Opens the front cover of the drive.
2. Connect the RS232 PC/Drive Serial Cable to the X2 serial connector.
3. Plug DB9 connector directly into any one of the computer serial COM port. Use one of the available serial ports, since this information will be necessary later on SuperDrive G2 Communication Setup during operation.
4. Configure the communication parameters on the drive. The communication parameters are described in Drive Parametrization.

SSW-07

Figure below shows how to connect a computer to the drive (RS232 point-to-point).

WARNING!
Switch off the drive before making the connections.

1. Take out the optional plug-in cover.
2. Replace the cover with the optional plug-in module. Make sure that the module is connected.
3. Insert the DB9 connector of the RS232 Connection Cable to the optional module (XC41 connector) and tighten the screws to fix the connector.
4. Plug DB9 connector directly into any one of the computer serial COM port. Use one of the
available serial ports, since this information will be necessary later on the SuperDrive G2 Communication Setup during operation.

5. Configure the communication parameters on the drive. The communication parameters are described in Drive Parametrization.

SSW-08

<table>
<thead>
<tr>
<th>WARNING!</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch off the drive before making the connections.</td>
</tr>
</tbody>
</table>

1. Take out the optional plug-in cover.
2. Replace the cover with the optional plug-in module. Make sure that the module is connected.
3. Insert the DB9 connector of the RS232 Connection Cable to the optional module (XC41 connector) and tighten the screws to fix the connector.
4. Plug DB9 connector directly into any one of the computer serial COM port. Use one of the available serial ports, since this information will be necessary later on the SuperDrive G2 Communication Setup during operation.
5. Configure the communication parameters on the drive. The communication parameters are described in Drive Parametrization.

MW500

<table>
<thead>
<tr>
<th>WARNING!</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch off the drive before making the connections.</td>
</tr>
</tbody>
</table>

1. Be sure that accessory RS232 Serial Interface Module is present and correctly connected to the drive.
2. Connect the DB9 connector from RS232 Connection Cable to the DB9 serial connector of RS232 Serial Interface Module.
3. Plug the another DB9 connector of cable directly into any one of the computer serial COM port. Use one of the available serial ports, since this information will be necessary later on the SuperDrive G2 Communication Setup during operation.
4. Configure the communication parameters on the drive. The communication parameters are described in Drive Parametrization.

CFW-09 PM

<table>
<thead>
<tr>
<th>WARNING!</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch off the drive before making the connections.</td>
</tr>
</tbody>
</table>

1. Remove the keypad (HMI) from the inverter.
2. Install RS232 Serial Interface Module in place of the keypad.
3. Connect the RS232 PC/Drive Serial Cable to the XC7 serial connector.
4. Plug DB9 connector directly into any one of the computer serial COM port. Use one of the available serial ports, since this information will be necessary later on the SuperDrive G2 Communication Setup during operation.
5. Configure the communication parameters on the drive. The communication parameters are described in Drive Parametrization.
8.5 RS485 Connection

The RS-485 standard (Recommended Standard 485) is a serial communication standard.

Based on differential signaling over a twisted pair, it is ideal for transmission at high speeds, over long distances and in environments prone to electromagnetic interference.

It allows communication between several elements (multipoint) on the same data network.

RS-485 is not a protocol, but simply an electrical interface.

The drive, which is the slave, must be located less than 1000 meters away from the computer (master).

CFW700 / CFW701

Figure below shows how to connect a computer to the drive (RS485 point-to-point).
Device manager in Windows indicates which serial port is connected to the USB RS485 converter. The computer name in device manager is purposely unreadable.

In SuperDrive G2, select the serial port correctly in Communication Setup window as follows.
WARNING!
Switch off the drive before making the connections.

1. Connect the type B connector of USB cable to the USB connector of the USB RS485 converter.
2. Connect the type A connector of USB cable to the computer USB port.
3. In device manager check which serial port is connected.
4. Check if in the SuperDrive G2 Communication Setup the selected connection type is serial.
5. The serial port in the window of communication setup window should be the same serial port that appears in the device manager, where the USB cable is connected.

CFW500 / CFW501

Figure below shows how to connect a computer to the drive (RS485 point-to-point).
Device manager in Windows indicates which serial port is connected to the USB RS485 converter. The computer name in device manager is purposely unreadable.

In SuperDrive G2, select the serial port correctly in Communication Setup window as follows.
**WARNING!**
Switch off the drive before making the connections.

1. Connect the type B connector of USB cable to the USB connector of the USB RS485 converter.
2. Connect the type A connector of USB cable to the computer USB port.
3. In device manager check which serial port is connected.
4. Check if in the SuperDrive G2 Communication Setup the selected connection type is serial.
5. The serial port in the window of communication setup window should be the same serial port that appears in the device manager, where the USB cable is connected.

**CFW100**

Figure below shows how to connect a computer to the drive (RS485 point-to-point).
Device manager in Windows indicates which serial port is connected to the USB RS485 converter.
The computer name in device manager is purposely unreadable.
In SuperDrive G2, select the serial port correctly in Communication Setup window as follows.
Communication

**WARNING!**
Switch off the drive before making the connections.

1. Connect the type B connector of USB cable to the USB connector of the USB RS485 converter.
2. Connect the type A connector of USB cable to the computer USB port.
3. In device manager check which serial port is connected.
4. Check if in the SuperDrive G2 Communication Setup the selected connection type is serial.
5. The serial port in the window of communication setup window should be the same serial port that appears in the device manager, where the USB cable is connected.

**MW500**

Figure below shows how to connect a computer to the drive (RS485 point-to-point).
Device manager in Windows indicates which serial port is connected to the USB RS485.
The computer name in device manager is purposely unreadable.

In SuperDrive G2, select the serial port correctly in Communication Setup window as follows.
WARNING!
Switch off the drive before making the connections.

1. Connect the type B connector of USB cable to the USB connector of the USB RS485 converter.
2. Connect the type A connector of USB cable to the computer USB port.
3. In device manager check which serial port is connected.
4. Check if in the SuperDrive G2 Communication Setup the selected connection type is serial.
5. The serial port in the window of communication setup window should be the same serial port that appears in the device manager, where the USB cable is connected.

ECW500

Figure below shows how to connect a computer to the drive (RS485 point-to-point).
P30008 = 38.4 Kbps (recommended)
P30008 = 0 (recommended)
P30010 = 1 (recommended)
Device manager in Windows indicates which serial port is connected to the USB RS485 converter. The computer name in device manager is purposely unreadable.

In SuperDrive G2, select the serial port correctly in Communication Setup window as follows.
**WARNING!**
Switch off the drive before making the connections.

1. Connect the type B connector of USB cable to the USB connector of the USB RS485 converter.
2. Connect the type A connector of USB cable to the computer USB port.
3. In device manager check which serial port is connected.
4. Check if in the SuperDrive G2 Communication Setup the selected connection type is serial.
5. The serial port in the window of communication setup window should be the same serial port that appears in the device manager, where the USB cable is connected.

**8.6 Bluetooth Connection**

Bluetooth is a global wireless and low-power-consumption communication standard that allows data exchange between devices over short distances.

The data exchange is done by means of radiofrequency, allowing a device to detect the other, regardless of their positions, as long as they are within a certain distance range.

The drive must be less than 1 m, 10 m or 100 m from the computer, depending on the Bluetooth technology available on your PC.
However, the use of Bluetooth devices requires pairing for communication.

To pair devices is to establish a connection between two Bluetooth devices (in this case, between a computer and the driver).

**CFW100**

The topics below present details on the use of the Bluetooth technology.

The steps presented in this chapter are valid for Windows 10.

For other operating systems (Windows 7 / 8 / 8.1), the steps are similar; see Windows help.

**Drive with CFW100-CBLT Accessory**

Make sure the drive has the Bluetooth communication module called CFW100-CBLT.

Make sure the drive has parameters P310, P311 and P312 set to the factory default values.

If the computer does not have Bluetooth technology, use a [adaptador USB Bluetooth](#).

---

<table>
<thead>
<tr>
<th>Class</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class 1</td>
<td>Up to 100 m (330 ft)</td>
</tr>
<tr>
<td>Class 2</td>
<td>Up to 10 m (33 ft)</td>
</tr>
<tr>
<td>Class 3</td>
<td>Up to 1 m (3 ft)</td>
</tr>
</tbody>
</table>

---

**NOTA!**

Once the Bluetooth is enabled on the computer, do not remove or replace the Bluetooth USB adapter during use.

For the proper operation of the CFW100 inverter with the CFW100-CBLT module, parameters P310, P311 and P312 must be set to the factory default values. During communication, the values of parameters P308, P310, P311 and P312 must not be changed. Otherwise, communication between the drive and the SuperDrive G2 will be lost.
Módulo de Comunicação Bluetooth

Make sure the LED of the drive Bluetooth communication module is on (ACTIVE). That indicates the CFW100-CBLT module is active.

The CFW100-CBLT communication module has two LEDs that indicate the communication status:

**01** - Red LED (ACTIVE): indicates the CFW100-CBLT module is active.

That means that, after the successful pairing, when the SuperDrive G2 starts communication with the CFW100 - for example, reading a drive parameter - the green LED turns on and will remain on even if no communication occurs between the drive and the SuperDrive G2. The LED will only turn off when the drive is turned off. When the drive is turned back on, the green LED remains off.

**02** - Green LED (STATUS): indicates the serial communication service of the CFW100-CBLT module is active.

PC with Active Bluetooth

Make sure the Bluetooth interface on the computer is turned on or the Bluetooth USB adapter is connected to the PC and working. The Bluetooth logo will appear on Windows taskbar.

The Bluetooth status on the PC can also be checked on Windows Settings window.
01 - One of the ways to view the settings is described below.

1. Press the key WIN + R,
2. Type `ms-settings:bluetooth`
3. Press OK
4. The Bluetooth settings window will open and you can check if the Bluetooth is active.

The window below illustrates the operation.

The blue button below indicates the Bluetooth is active on the computer.

02 - A second way to view the settings is described below.
Windows Start Menu > Settings > Devices > Bluetooth & other devices = check if the Bluetooth status is active.

**CONNECT THE COMPUTER TO THE DRIVE VIA BLUETOOTH**

Only two steps are necessary to prepare the environment to use the Bluetooth:

01 - First, it is necessary to pair Windows with the drive (see item Pairing Windows with the Drive),

02 - Then you should configure the SuperDrive G2 for Bluetooth communication (see item Configuring the Bluetooth Communication on the SuperDrive G2).

After those two steps, the SuperDrive G2 will be ready to communicate with the drive via Bluetooth.

**Pairing Window with the Drive**

At the first use, Windows requests the execution of some additional steps as follows.

01 - Turn on the CFW100 (with Bluetooth) and make it discoverable.

02 - Click Windows Start Menu button on the left corner of the screen. After that, select the Settings icon.

03 - On the Settings window, click on Devices.
04 - The Devices window pops up. On the left menu of such window, select Bluetooth & other devices.

Make sure the Bluetooth technology is activated in Windows (Bluetooth button ON).
- Click on the Add Bluetooth or other device button.
The Add a device window pops up.
- Click on the Bluetooth button.
- At this moment, Windows starts looking for Bluetooth devices.
09 - Windows shows the device found on the screen. In this case, a CFW100 was found. The code shown is the content of parameter 770 (P770 = 7367).

Click on the device found.
NOTA!
Always use a unique code (content of P770) for each drive.

Some Bluetooth devices require authentication before pairing.

The CFW100 is a device that requires authentication. A message will be displayed on the window with a code generated by Windows.

Always accept that code (it may be a different number from the one shown below).

Click the Connect button to continue.
At this moment, Windows executes the pairing and shows a message saying that the device is ready to go.
- A Windows notification usually pops up saying the device is ready. That notification disappears automatically.

- Also on the Devices window, with the Bluetooth & other devices selected (menu on the left of the window), the paired device (CFW100) appears on the paired device list as shown below.
Configuring the Bluetooth Communication on the SuperDrive G2

On the SuperDrive G2, it is necessary to configure the same output serial COM port that Windows reserved for Bluetooth. See the steps below.

01 - Open the Windows Bluetooth settings window (Bluetooth & other devices).
- Move the scroll bar to find the link **More Bluetooth options**. Click on that link.
Windows Bluetooth Settings window pops up. Select the COM Ports tab.

For each Bluetooth device, 2 COM ports are used. Check which is the output COM port (Output Direction).

In this example, the output COM4 port will be used in the configuration of the SuperDrive G2.
- In the Windows device manager, you can also see the serial ports used by the Bluetooth interface.

In this example, the ports are COM4 and COM5.
05 - On the SuperDrive G2, Communication Setup window, select the connection type (Bluetooth).
06 - On this window, you can see the fields:

- Transmission delay,
- Response delay,
- Time out and
- Data on the serial port (read only) used by the Bluetooth.

You must set the device, serial port, data bits, stop bits, parity and baud rate of the serial port selected for Bluetooth.

In order to do that, click on the field of the current equipment (in this example **User Setting**) or the **Serial** radio button.

07 - On the RS232 serial communication window, set the equipment and the serial port as previously observed in the Bluetooth settings.

The other fields should also be set (data bits, stop bits, parity and baud rate).

In this example, the output port is COM4.
- Return to the Bluetooth interface on this window. Check if the port used by the Bluetooth is the same as the one previously selected in the RS232 serial interface.
Now the SuperDrive G2 is ready to communicate with the CFW100 via Bluetooth.

**Removing a Bluetooth Device from Windows (Unpair)**

Below are the steps to remove a Bluetooth device from Windows.

01 - Click on the Windows Start Menu button on the left corner of the screen. After that, select the Settings icon.
02 - On the Settings window, click on Devices.

03 - The Devices window pops up. On the left menu of such window, select Bluetooth & other devices.

The list of paired devices is displayed on the right side of the window.
- Select and click the paired device. A Remove button is enabled.

Click on the Remove device button.
- A message prompts the confirmation to remove it. Click on Yes.

Are you sure you want to remove this device?

Yes

- At this moment, Windows removes the device, and it is erased from the window.
ERRORS

01 - If a pairing error between Windows and the drive occurred, check the following items:

- Check if there are obstacles between the drive and the computer;
- Check if the drive is not too far away from the PC;
- Check if there is another PC with Bluetooth enabled which is trying to connect to the same drive.

8.7 Ethernet Connection

Ethernet is an interconnection technology for local networks - Local Area Network (LAN) - based on the transmission of packages. It defines the electric signals for the physical layer, in addition to the package format and protocols for the Media Access Control (MAC) of the OSI model.

Ethernet, however, mainly defines the media and package format. Based on Ethernet, several higher level protocols and services were specified and developed so as to allow the execution of the desired tasks via network, such as package routing, establishment of connection, file transmission and reception, etc. Several of those protocols were also widely spread and used, such as IP, TCP, UDP, FTP and HTTP.

Widely used to interconnect computers in offices, the Ethernet technology also started to be employed in industrial environments to interconnect field equipment. For the industrial
environment, different communication protocols were created based on Ethernet, for instance, Modbus TCP, EtherNet/IP and PROFINET.

Click on the link to go directly to the products: CFW-11 CFW500 / MW500 SCA-06

**CFW-11**

The CFW-11 frequency inverter offers the Anybus-CC communication modules as accessory items.

In order to use the SuperDrive G2 with the CFW-11 on Ethernet, an Anybus-CC accessory must be connected to the drive according to the protocol used:

<table>
<thead>
<tr>
<th>Protocol</th>
<th>Accessory</th>
<th>Image</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EtherNet/IP</td>
<td>ETHERNETIP-05</td>
<td><img src="EtherNETIP-05" alt="Image" /></td>
<td>1 Ethernet port</td>
</tr>
<tr>
<td>EtherNet/IP</td>
<td>ETHERNET-2P-05</td>
<td><img src="ETHERNET-2P-05" alt="Image" /></td>
<td>2 Ethernet ports with built-in switch</td>
</tr>
<tr>
<td>Modbus TCP</td>
<td>MODBUSTCP-05</td>
<td><img src="MODBUSTCP-05" alt="Image" /></td>
<td>1 Ethernet port</td>
</tr>
<tr>
<td>PROFINET IO</td>
<td>PROFINETIO-05</td>
<td><img src="PROFINETIO-05" alt="Image" /></td>
<td>2 Ethernet ports with built-in switch</td>
</tr>
</tbody>
</table>

For further details on the specific characteristics and functionalities of the protocols, refer to the Anybus-CC user's manual of the CFW-11.

---

**Example 01  Configuration Using Peer-to-Peer Modbus TCP Protocol - CFW-11**

01 - Install the MODBUSTCP-05 accessory on the CFW-11.
For further information, refer to the Anybus-CC installation guide of the CFW-11.

**02** - View the parameter below (read only), which allows identifying the Ethernet module type connected to the equipment.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Adjustable Range</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>P0723</td>
<td>Anybus ID</td>
<td>0 = Inactive</td>
<td>21 = Modbus TCP</td>
</tr>
<tr>
<td></td>
<td></td>
<td>...</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>21 = Modbus TCP</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>...</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>25 = Reserved</td>
<td></td>
</tr>
</tbody>
</table>

**03** - View/set the parameters below.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Adjustable Range</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>P0841</td>
<td>Baud Rate</td>
<td>0 = Auto</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 = 10 Mbps, half duplex</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 = 10 Mbps, full duplex</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>3 = 100 Mbps, half duplex</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>4 = 100 Mbps, full duplex</td>
<td></td>
</tr>
<tr>
<td>P0842</td>
<td>Time-out Modbus TCP</td>
<td>0 ... 655</td>
<td>0</td>
</tr>
<tr>
<td>P0843</td>
<td>IP Address Configuration</td>
<td>0 = Parameters 1 = DHCP 2 = DCP 3 = IPconfig</td>
<td>0 = Parameters</td>
</tr>
<tr>
<td>P0844</td>
<td>IP1 Address</td>
<td>0 ... 255</td>
<td>192</td>
</tr>
<tr>
<td>P0845</td>
<td>IP2 Address</td>
<td>0 ... 255</td>
<td>168</td>
</tr>
<tr>
<td>P0846</td>
<td>IP3 Address</td>
<td>0 ... 255</td>
<td>0</td>
</tr>
<tr>
<td>P0847</td>
<td>IP4 Address</td>
<td>0 ... 255</td>
<td>10</td>
</tr>
</tbody>
</table>

**04** - Once the parameters are set, it is necessary to restart the equipment.

It informs the communication module status:
### Communication

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Adjustable Range</th>
<th>Value</th>
</tr>
</thead>
</table>
| P0724      | Anybus Communication Status | 0 = Disable  
1 = Not Supported  
2 = Access Error  
3 = Offline  
4 = Online | 4 = Online |

05 - Configure the Ethernet network in Windows operating system; follow the directions of items 05.01 ... 05.08.

**NOTA!**

If the computer does not have an Ethernet port, it is necessary to use an Ethernet network adapter. For further details, see the topic Ethernet Network Adapter.

05.01 - Open the control panel.

05.02 - Select Network and Sharing Center.
- Select the Unidentified network (Public network) by clicking according to the figure. In this case, the link is Ethernet 4.
**05.04** - The network status is displayed. Click on the Properties button.

**05.05** - The Properties window pops up. Select Internet Protocol Version 4 (TCP/IPv4) and click on the Properties button.
05.06 - The IPV4 Properties window is shown without any addresses configured.
05.07 - Select the Use the following IP address option.

Fill out the fields with the addresses as follows.

Click on the OK button to end the task.
05.08 - At this moment, the Ethernet network is properly configured in Windows operating system.

06 - In SuperDrive G2, configure the Ethernet connection in the Communication Setup window.

A time-out above 5000 ms is recommended. Lower values may produce faults during communication.

Set the IP Address, Port and Unit ID fields as follows.
- Now, communication between the drive and computer is possible.

---

**Example 02** Configuration Using Peer-to-Peer EtherNet/IP Protocol - CFW-11

**01** - Install the ETHERNETIP-05 accessory on the CFW-11.

For further information, refer to the Anybus-CC installation guide of the CFW-11.

**02** - View the parameter below (read only), which allows identifying the Ethernet module type connected to the equipment.
### Communication

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Adjustable Range</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>P0723</td>
<td>Anybus ID</td>
<td>0 = Inactive</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>...</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>19 = EtherNet/IP</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>25 = Reserved</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>19 = EtherNet/IP</td>
<td></td>
</tr>
</tbody>
</table>

03 - Visualize/ajuste os parâmetros abaixo.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Adjustable Range</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>P0841</td>
<td>Baud Rate</td>
<td>0 = Auto</td>
<td>0 = Auto</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 = 10 Mbps, half duplex</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 = 10 Mbps, full duplex</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>3 = 100 Mbps, half duplex</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>4 = 100 Mbps, full duplex</td>
<td></td>
</tr>
<tr>
<td>P0842</td>
<td>Time-out Modbus TCP</td>
<td>0 ... 655</td>
<td>No Used</td>
</tr>
<tr>
<td>P0843</td>
<td>IP Address Configuration</td>
<td>0 = Parameters</td>
<td>0 = Parameters</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 = DHCP</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 = DCP</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>3 = IPconfig</td>
<td></td>
</tr>
<tr>
<td>P0844</td>
<td>IP1 Address</td>
<td>0 ... 255</td>
<td>192</td>
</tr>
<tr>
<td>P0845</td>
<td>IP2 Address</td>
<td>0 ... 255</td>
<td>168</td>
</tr>
<tr>
<td>P0846</td>
<td>IP3 Address</td>
<td>0 ... 255</td>
<td>0</td>
</tr>
<tr>
<td>P0847</td>
<td>IP4 Address</td>
<td>0 ... 255</td>
<td>10</td>
</tr>
</tbody>
</table>

04 - Once the parameters are set, it is necessary to restart the equipment.

It informs the communication module status:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Adjustable Range</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>P0724</td>
<td>Anybus Communication Status</td>
<td>0 = Disable</td>
<td>4 = Online</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 = Not Supported</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 = Access Error</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>3 = Offline</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>4 = Online</td>
<td></td>
</tr>
</tbody>
</table>

05 - The following steps are the same as those used in Example 01 of the CFW-11.

---

Example 03  **Configuration Using Peer-to-Peer PROFINET Protocol - CFW-11**

01 - Install the PROFINETIO-05 accessory on the CFW-11.
For further information, refer to the Anybus-CC installation guide of the CFW-11.

02 - View the parameter below (read only), which allows identifying the Ethernet module type connected to the equipment.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Adjustable Range</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>P0723</td>
<td>Anybus ID</td>
<td>0 = Inactive</td>
<td>23 = PROFINET IO</td>
</tr>
<tr>
<td></td>
<td></td>
<td>... 23 = PROFINET IO</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>... 25 = Reserved</td>
<td></td>
</tr>
</tbody>
</table>

03 - View/set the parameters below.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Adjustable Range</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>P0841</td>
<td>Baud Rate</td>
<td>0 = Auto</td>
<td>0 = Auto</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 = 10 Mbps, half duplex</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 = 10 Mbps, full duplex</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>3 = 100 Mbps, half duplex</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>4 = 100 Mbps, full duplex</td>
<td></td>
</tr>
<tr>
<td>P0842</td>
<td>Time-out Modbus TCP</td>
<td>0 ... 655</td>
<td>Not Used</td>
</tr>
<tr>
<td>P0843</td>
<td>IP Address Configuration</td>
<td>0 = Parameters</td>
<td>0 = Parameters</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 = DHCP</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 = DCP</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>3 = IPconfig</td>
<td></td>
</tr>
<tr>
<td>P0844</td>
<td>IP1 Address</td>
<td>0 ... 255</td>
<td>192</td>
</tr>
<tr>
<td>P0845</td>
<td>IP2 Address</td>
<td>0 ... 255</td>
<td>168</td>
</tr>
<tr>
<td>P0846</td>
<td>IP3 Address</td>
<td>0 ... 255</td>
<td>0</td>
</tr>
<tr>
<td>P0847</td>
<td>IP4 Address</td>
<td>0 ... 255</td>
<td>10</td>
</tr>
</tbody>
</table>

04 - Once the parameters are set, it is necessary to restart the equipment.

It informs the communication module status:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Adjustable Range</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>P0724</td>
<td>Anybus Communication Status</td>
<td>0 = Disable</td>
<td>4 = Online</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 = Not Supported</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 = Access Error</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>3 = Offline</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>4 = Online</td>
<td></td>
</tr>
</tbody>
</table>
**05** - The following steps are the same as those used in [Example 01](#) of the CFW-11.

---

**CFW500 / MW500**

In order to use the Ethernet network, it is necessary to install the proper accessory.

There are three different plug-in modules, according to the specified communication protocol:

<table>
<thead>
<tr>
<th>Protocol</th>
<th>Accessory</th>
<th>Image</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modbus TCP</td>
<td>CFW500-CEMB-TCP</td>
<td><img src="image1.png" alt="Image" /></td>
<td>1 Ethernet port</td>
</tr>
<tr>
<td>EtherNet/IP</td>
<td>CFW500-CETH-IP</td>
<td><img src="image2.png" alt="Image" /></td>
<td>1 Ethernet port</td>
</tr>
<tr>
<td>PROFINET IO</td>
<td>CFW500-CEPN-IO</td>
<td><img src="image3.png" alt="Image" /></td>
<td>1 Ethernet port</td>
</tr>
</tbody>
</table>

For further details on the specific characteristics and functionalities of the protocols, refer to the Ethernet user's manual of the CFW500.

---

**Example 01**  Configuration Using Peer-to-Peer Modbus TCP Protocol - CFW500

**01** - Install the CFW500-CEMB-TCP accessory on the CFW500.

For further information, refer to the installation guide of the corresponding accessory.

**02** - View the parameter below (read only), which allows identifying the Ethernet module type connected to the equipment.
### Communication

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Adjustable Range</th>
<th>Value</th>
</tr>
</thead>
</table>
| P0800     | Ethernet module identification | 0 = Unidentified  
1 = Modbus TCP  
2 = EtherNet/IP  
3 = PROFINET IO | 1 = Modbus TCP |

**03** - View/set the parameters below.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Adjustable Range</th>
<th>Value</th>
</tr>
</thead>
</table>
| P0803     | Ethernet Baud Rate | 0 = Auto  
1 = 10Mbit/s, half duplex  
2 = 10Mbit/s, full duplex  
3 = 100Mbit/s, half duplex  
4 = 100Mbit/s, full duplex | 0 = Auto |
| P0806     | Watchdog Modbus TCP | 0,0 ... 65,5 s | 0,0 |
| P0810     | IP Address Configuration | 0 = Parameters  
1 = DHCP | 0 = Parameters |
| P0811     | IP1 Address | 0 ... 255 | 192 |
| P0812     | IP2 Address | 0 ... 255 | 168 |
| P0813     | IP3 Address | 0 ... 255 | 0 |
| P0814     | IP4 Address | 0 ... 255 | 10 |

**04** - Once the parameters are set, it is necessary to restart the equipment.

**05** - Configure the Ethernet network in Windows operating system; follow the directions of items 05.01 ... 05.08.

**NOTA!**

- If the computer does not have an Ethernet port, it is necessary to use an Ethernet network adapter. For further details, see the topic [Ethernet Network Adapter](#).

**05.01** - Open the control panel.
05.02 - Select Network and Sharing Center.
- Select the Unidentified network (Public network) by clicking according to the figure. In this case the link is Ethernet 4.
05.04 - The network status is displayed. Click on the Properties button.

05.05 - The Properties window pops up. Select Internet Protocol Version 4 (TCP/IPv4) and click on the Properties button.
- The IPV4 Properties window is shown without any addresses configured.
05.07 - Select the Use the following IP address option.

Fill out the fields with the addresses indicated below.

Click the OK button to end the task.
05.08 - At this moment, the Ethernet network is properly configured in Windows operating system.

06 - In SuperDrive G2, configure the Ethernet connection in the Communication Setup window.

A time-out above 5000 ms is recommended. Lower values may produce faults during communication.

Set the IP Address, Port and Unit ID fields as follows.
Now, communication between the drive and computer is possible.

**Example 02  Configuration Using Peer-to-Peer EtherNet/IP Protocol - CFW500**

1. Install the CFW500-CETH-IP accessory on the CFW500.

For further information, refer to the installation guide of the corresponding accessory.
02 - View the parameter below (read only), which allows identifying the Ethernet module type connected to the equipment.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Adjustable Range</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>P0800</td>
<td>Ethernet module identification</td>
<td>0 = Unidentified</td>
<td>2 = EtherNet/IP</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 = Modbus TCP</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 = EtherNet/IP</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>3 = PROFINET IO</td>
<td></td>
</tr>
</tbody>
</table>

03 - View/set the parameters below.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Adjustable Range</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>P0803</td>
<td>Baud Rate Ethernet</td>
<td>0 = Auto</td>
<td>0 = Auto</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 = 10Mbit/s, half duplex</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 = 10Mbit/s, full duplex</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>3 = 100Mbit/s, half duplex</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>4 = 100Mbit/s, full duplex</td>
<td></td>
</tr>
<tr>
<td>P0806</td>
<td>Watchdog Modbus TCP</td>
<td>0,0 ... 65,5 s</td>
<td>0,0</td>
</tr>
<tr>
<td>P0810</td>
<td>IP Address Configuration</td>
<td>0 = Parameters</td>
<td>0 = Parameters</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 = DHCP</td>
<td></td>
</tr>
<tr>
<td>P0811</td>
<td>IP1 Address</td>
<td>0 ... 255</td>
<td>192</td>
</tr>
<tr>
<td>P0812</td>
<td>IP2 Address</td>
<td>0 ... 255</td>
<td>168</td>
</tr>
<tr>
<td>P0813</td>
<td>IP3 Address</td>
<td>0 ... 255</td>
<td>0</td>
</tr>
<tr>
<td>P0814</td>
<td>IP4 Address</td>
<td>0 ... 255</td>
<td>10</td>
</tr>
</tbody>
</table>

04 - Once the parameters are set, it is necessary to restart the equipment.

05 - The following steps are the same as those used in Example 01 of the CFW500.

Example 03  Configuration Using Peer-to-Peer PROFINET IO Protocol - CFW500

01 - Install the CFW500-CEPN-IO accessory on the CFW500.
For further information, refer to the installation guide of the corresponding accessory.

02 - View the parameter below (read only), which allows identifying the Ethernet module type connected to the equipment.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Adjustable Range</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>P0800</td>
<td>Ethernet module identification</td>
<td>0 = Unidentified, 1 = Modbus TCP, 2 = EtherNet/IP, 3 = PROFINET IO</td>
<td>3 = PROFINET IO</td>
</tr>
</tbody>
</table>

03 - View/set the parameters below.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Adjustable Range</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>P0803</td>
<td>Ethernet Baud Rate</td>
<td>0 = Auto, 1 = 10Mbit/s, half duplex, 2 = 10Mbit/s, full duplex, 3 = 100Mbit/s, half duplex, 4 = 100Mbit/s, full duplex</td>
<td>0 = Auto</td>
</tr>
<tr>
<td>P0806</td>
<td>Watchdog Modbus TCP</td>
<td>0,0 ... 65,5 s</td>
<td>0,0</td>
</tr>
<tr>
<td>P0810</td>
<td>IP Address Configuration</td>
<td>0 = Parameters, 1 = DHCP</td>
<td>0 = Parameters</td>
</tr>
<tr>
<td>P0811</td>
<td>IP1 Address</td>
<td>0 ... 255</td>
<td>192</td>
</tr>
<tr>
<td>P0812</td>
<td>IP2 Address</td>
<td>0 ... 255</td>
<td>168</td>
</tr>
<tr>
<td>P0813</td>
<td>IP3 Address</td>
<td>0 ... 255</td>
<td>0</td>
</tr>
<tr>
<td>P0814</td>
<td>IP4 Address</td>
<td>0 ... 255</td>
<td>10</td>
</tr>
</tbody>
</table>

04 - Once the parameters are set, it is necessary to restart the equipment.

05 - The following steps are the same as those used in Example 01 of the CFW500.
**SCA-06**

The SCA-06 servo drive has the ECO5, ECO6 and ECO7 communication modules as accessory items.

In order to use the SuperDrive G2 with SCA-06 on Ethernet, an accessory must be connected to the drive according to the protocol used:

<table>
<thead>
<tr>
<th>Protocol</th>
<th>Accessory</th>
<th>Image</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EtherNet/IP</td>
<td>ECO5</td>
<td><img src="image" alt="ECO5 Image" /></td>
<td>2 Ethernet ports</td>
</tr>
<tr>
<td>Modbus TCP</td>
<td>ECO6</td>
<td><img src="image" alt="ECO6 Image" /></td>
<td>2 Ethernet ports</td>
</tr>
<tr>
<td>PROFINET IO</td>
<td>ECO7</td>
<td><img src="image" alt="ECO7 Image" /></td>
<td>2 Ethernet ports</td>
</tr>
</tbody>
</table>

For further details on the specific characteristics and functionalities of the protocols, refer to the Ethernet communication manual of the SCA-06.

---

**Example 01**  **Configuration Using Peer-to-Peer Modbus TCP Protocol - SCA-06**
01 - Install the ECO06 accessory on the SCA-06.

For further information, refer to the Installation, Configuration and Operation Guide of the ECO6 accessory of the SCA-06.

02 - View the parameter below (read only), which allows identifying the Ethernet module type connected to the equipment.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Adjustable Range</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>P0800</td>
<td>Ethernet Module Identification</td>
<td>0 = Unidentified 1 = Modbus TCP 2 = EtherNet/IP 3 = PROFINET IO</td>
<td>1 = Modbus TCP</td>
</tr>
</tbody>
</table>

03 - View/set the parameters below.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Adjustable Range</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>P0803</td>
<td>Ethernet Baud Rate</td>
<td>0 = Auto 1 = 10Mbit/s, half duplex 2 = 10Mbit/s, full duplex 3 = 100Mbit/s, half duplex 4 = 100Mbit/s, full duplex</td>
<td>0 = Auto</td>
</tr>
<tr>
<td>P0806</td>
<td>Watchdog Modbus TCP</td>
<td>0,0 ... 65,5 s</td>
<td>0,0</td>
</tr>
<tr>
<td>P0810</td>
<td>IP Address Configuration</td>
<td>0 = Parameters 1 = DHCP</td>
<td>0 = Parameters</td>
</tr>
<tr>
<td>P0811</td>
<td>IP1 Address</td>
<td>0 ... 255</td>
<td>192</td>
</tr>
<tr>
<td>P0812</td>
<td>IP2 Address</td>
<td>0 ... 255</td>
<td>168</td>
</tr>
<tr>
<td>P0813</td>
<td>IP3 Address</td>
<td>0 ... 255</td>
<td>0</td>
</tr>
<tr>
<td>P0814</td>
<td>IP4 Address</td>
<td>0 ... 255</td>
<td>10</td>
</tr>
</tbody>
</table>

04 - Once the parameters are set, it is necessary to restart the equipment.
05 - Configure the Ethernet network in Windows operating system; follow the directions of items 05.01 ... 05.08.

**NOTA!**
If the computer does not have an Ethernet port, it is necessary to use an Ethernet network adapter. For further details, see the topic [Ethernet Network Adapter](#).

05.01 - Open the control panel.

05.02 - Select Network and Sharing Center.
- Select the Unidentified network (Public network) by clicking according to the figure. In this case the link is Ethernet 4.
05.04 - The network status is displayed. Click on the Property button.

05.05 - The Properties window pops up. Select Internet Protocol Version 4 (TCP/IPv4) and click on the Properties button.
05.06 - The IPV4 Properties window is shown without any addresses configured.
- Select the **Use the following IP address** option.

Fill out the fields with the addresses indicated below.

Click the **OK** button to end the task.
At this moment, the Ethernet network is properly configured in Windows operating system.

In SuperDrive G2, configure the Ethernet connection in the Communication Setup window.

A time-out above 5000 ms is recommended. Lower values may produce faults during communication.

Set the IP Address, Port and Unit ID fields as follows.
07 - Now, communication between the drive and computer is possible.

Example 02  Configuration Using Peer-to-Peer EtherNet/IP Protocol - SCA-06

01 - Install the ECO05 accessory on the SCA-06.

For further information, refer to the Installation, Configuration and Operation Guide of the ECO5
accessory of the SCA-06.

02 - View the parameter below (read only), which allows identifying the Ethernet module type connected to the equipment.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Adjustable Range</th>
<th>Value</th>
</tr>
</thead>
</table>
| P0800     | Ethernet Module Identification | 0 = Unidentified  
1 = Modbus TCP  
2 = EtherNet/IP  
3 = PROFINET IO | 2 = EtherNet/IP |

03 - View/set the parameters below.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Adjustable Range</th>
<th>Value</th>
</tr>
</thead>
</table>
| P0803     | Ethernet Baud Rate        | 0 = Auto  
1 = 10Mbit/s, half duplex  
2 = 10Mbit/s, full duplex  
3 = 100Mbit/s, half duplex  
4 = 100Mbit/s, full duplex | 0 = Auto |
| P0806     | Watchdog Modbus TCP       | 0,0 ... 65,5 s                                       | 0,0     |
| P0810     | IP Address Configuration  | 0 = Parameters  
1 = DHCP | 0 = Parameters |
| P0811     | IP1 Address               | 0 ... 255                                            | 192     |
| P0812     | IP2 Address               | 0 ... 255                                            | 168     |
| P0813     | IP3 Address               | 0 ... 255                                            | 0       |
| P0814     | IP4 Address               | 0 ... 255                                            | 10      |

04 - Once the parameters are set, it is necessary to restart the equipment.

05 - The following steps are the same as those used in Example 01 of the SCA-06.

Example 03 Configuration Using Peer-to-Peer PROFINET IO Protocol - SCA-06

01 - Install the ECO07 accessory on the SCA-06.
Communication

For further information, refer to the Installation, Configuration and Operation Guide of the ECO7 accessory of the SCA-06.

02 - View the parameter below (read only), which allows identifying the Ethernet module type connected to the equipment.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Adjustable Range</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>P0800</td>
<td>Ethernet Module Identification</td>
<td>0 = Unidentified</td>
<td>3 = PROFINET IO</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 = Modbus TCP</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 = EtherNet/IP</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>3 = PROFINET IO</td>
<td></td>
</tr>
</tbody>
</table>

03 - View/set the parameters below.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Adjustable Range</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>P0803</td>
<td>Ethernet Baud Rate</td>
<td>0 = Auto</td>
<td>0 = Auto</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 = 10Mbit/s, half duplex</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 = 10Mbit/s, full duplex</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>3 = 100Mbit/s, half duplex</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>4 = 100Mbit/s, full duplex</td>
<td></td>
</tr>
<tr>
<td>P0806</td>
<td>Watchdog Modbus TCP</td>
<td>0,0 ... 65,5 s</td>
<td>0,0</td>
</tr>
<tr>
<td>P0810</td>
<td>IP Address Configuration</td>
<td>0 = Parameters</td>
<td>0 = Parameters</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 = DHCP</td>
<td></td>
</tr>
<tr>
<td>P0811</td>
<td>IP1 Address</td>
<td>0 ... 255</td>
<td>192</td>
</tr>
<tr>
<td>P0812</td>
<td>IP2 Address</td>
<td>0 ... 255</td>
<td>168</td>
</tr>
<tr>
<td>P0813</td>
<td>IP3 Address</td>
<td>0 ... 255</td>
<td>0</td>
</tr>
<tr>
<td>P0814</td>
<td>IP4 Address</td>
<td>0 ... 255</td>
<td>10</td>
</tr>
</tbody>
</table>

04 - Once the parameters are set, it is necessary to restart the equipment.

05 - The following steps are the same as those used in Example 01 of the SCA-06.
8.8 RS232 Cable

RS232 PC/DRIVE SERIAL CABLE

Drive: CFW-09 PM, SSW-06

Figure below shows the cable parts for point-to-point RS232 connection. Only pins 2, 3 and 5 of the DB9 female connector are used.

Maximum cable length: 10 meters.

RS232 CONNECTION CABLE

Drive: SSW-07, SSW-08

Figure below shows the cable parts for point-to-point RS232 connection. Only pins 2, 3 and 5 of the DB9 female connector are used.

Maximum cable length: 10 meters.

8.9 USB Cable

USB CABLE

Drive: CFW-11, SCA-06, SSW7000, CTW900

Figure below shows the cable parts for point-to-point USB connection.
Communication

Figure below shows the connectors.

A = Type A connector  
B = Type B connector

Maximum cable length: 3 meters.

Always use a standard host/device shielded USB cable. Unshielded cables may lead to communication errors.

The USB connection is galvanically isolated from the mains power supply and from other high voltages internal to the inverter. However, the USB connection is not isolated from the Protective Ground (PE). Use an isolated computer for the USB connection or a desktop connected to the same Protective Ground (PE) of the inverter.

Purchase Suggestions

Manufacturer:

- Samtec, Inc: http://www.samtec.com/

If you want to buy USB cable directly from Samtec, please see below.

<table>
<thead>
<tr>
<th>Description</th>
<th>Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>USB shielded High Speed Cable, 1 m, Samtec</td>
<td>USBC-AM-MB-B-B-S-1</td>
</tr>
<tr>
<td>USB shielded High Speed Cable, 2 m, Samtec</td>
<td>USBC-AM-MB-B-B-S-2</td>
</tr>
<tr>
<td>USB shielded High Speed Cable, 3 m, Samtec</td>
<td>USBC-AM-MB-B-B-S-3</td>
</tr>
</tbody>
</table>

At the time this help was being written, the specification was found at http://www.samtec.com/ftppub/cpdf/USBC-AM-BM-B-B-S-X-MKT.pdf

USB CABLE (mini-B)

Drive: CFW100, CFW700, CFW701
Communication

Figure below shows the cable parts for point-to-point USB connection.

Figure below shows the connectors.

A = Type A connector
B = Type mini-B connector

Maximum cable length: 3 meters.

Always use a standard host/device shielded USB cable. Unshielded cables may lead to communication errors.

The USB connection is galvanically isolated from the mains power supply and from other high voltages internal to the inverter. However, the USB connection is not isolated from the Protective Ground (PE). Use an isolated computer for the USB connection or a desktop connected to the same Protective Ground (PE) of the inverter.

Purchase Suggestions

Manufacturer:


If you want to buy USB cable directly from Samtec, please see below.

<table>
<thead>
<tr>
<th>Description</th>
<th>Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>USB shielded High Speed Cable, 1 m, Samtec</td>
<td>USBC-AM-BM-B-B-S-1</td>
</tr>
<tr>
<td>USB shielded High Speed Cable, 2 m, Samtec</td>
<td>USBC-AM-BM-B-B-S-2</td>
</tr>
<tr>
<td>USB shielded High Speed Cable, 3 m, Samtec</td>
<td>USBC-AM-BM-B-B-S-3</td>
</tr>
</tbody>
</table>
At the time this help was being written, the specification was found at [http://www.samtec.com/ftppub/cpdf/USBC-AM-MB-B-B-S-X-X-MKT.pdf](http://www.samtec.com/ftppub/cpdf/USBC-AM-MB-B-B-S-X-X-MKT.pdf)

8.10 Ethernet Cable

This cable is used to connect the SuperDrive G2 to the Ethernet drive.

This cable has RJ45 connectors at both ends.

The figure below shows an example of this cable.

![Ethernet Cable Example](image)

8.11 USB to Serial Adapter

The USB to serial adapter is the best solution for the connection of serial equipment (RS232) to USB ports, i.e., for connecting computer USB output to a RS232 serial equipment.

This is a low cost solution and meets the install requirements of new computer serial ports that have busy bus bars or equipments that are not fitted with RS232 ports.

The USB to serial adapter allows the plug & play connection with your computer, thus maintaining free the existing serial port.

Figures below show a sample of this adapter.

### PURCHASE SUGGESTIONS

**Manufacturer:** Comm5 Tecnologia

<table>
<thead>
<tr>
<th>Product</th>
<th>Conversor de USB para 1 saída serial RS232</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model</td>
<td>1S-USB - conversor USB para 1 serial</td>
</tr>
<tr>
<td>Web Site</td>
<td><a href="https://www.comm5.com.br/produtos/conversor-usb/1s-usb/">https://www.comm5.com.br/produtos/conversor-usb/1s-usb/</a></td>
</tr>
</tbody>
</table>

For further information about product installation, please refer to user's manual.
Manufacturer: Tripp Lite

<table>
<thead>
<tr>
<th>Product</th>
<th>High-Speed USB-to-Serial Adapter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model</td>
<td>USA-19HS</td>
</tr>
</tbody>
</table>

For further information about product installation, please refer to user's manual.

8.12 Bluetooth USB Adapter

Drive: CFW100

The image below shows an USB Bluetooth adapter (a.k.a. dongle) which should be connected to the USB port of computer. There are several models with different features.
8.13 Ethernet Network Adapter

The Ethernet network adapter is an adapter that allows connecting a computer with a USB port to a device using the Ethernet.

This adapter is usually light, easy to use and very practical.

The adapter features a USB port type A at one end and a RJ-45 port at the other, being a standard fitting for a variety of compatible devices.

This adapter eliminates the use of other cables or adapters.

Also, no external power supplies are necessary.

The figure below shows an example of an Ethernet network adapter.

Example of Connection Using an Ethernet Network Adapter

01 - Connect the Ethernet network adapter (USB connector to RJ45 connector) to the computer.

The adapter USB port (type A connector) is connected to the computer USB port.

Then, connect the drive (equipment) Ethernet cable to the network adapter.

The simplified figure below shows the connection of the drive to the computer using an Ethernet cable and Ethernet network adapter.
02 - Check the Windows device manager.

Notice that Windows operating system recognized the hardware.

In this example, the adapter is shown as Realtek USB FE Family Controller

03 - Device Not Recognized.

In case Windows operating system does not recognize the device (Ethernet network adapter), the adapter drive, supplied by the manufacturer, must be installed.

After the driver installation, Windows recognizes the device.
8.14 Before Trying to Establish Communication

Before trying to establish communication make sure the following has been done:

- Communication cable connected to the drive;
- Communication cable connected to computer;
- Drive is powered up;
- Communication parameters on the drive correspond to SuperDrive G2 communication settings.

8.15 Exception During Monitoring

SOFT-STARTER

SSW-06 V1.3X

- P014 to P017 = 13107 => this means there is no fault.

SSW-07 and SSW-08

- P219 defines parametrization mode for the following parameters: P101, P102, P104, P110, P202, P206, P401, P520, P521, P611, P613, P617, P620 and P640;
- On Trimpot and Dip Switch Mode, the parametrization of the above parameters is done through the Trimpots and Dip Switches. These parameters act like read only parameters, showing the Trimpots and Dip Switches programmed values. The values which where programmed through RS232 serial communication are not used;
- On Keypad Mode, the parametrization of parameters previously cited is made with RS232 serial communication or Keypad. The value adjusted with Trimpots and Dip Switch are not used.
9  Context menus

Contents of this chapter:

- Rename
- Save As
- Close

9.1  Project

ACCESS

Toolbar: none
Context Menu
Shortcut Key: none

FUNCTION

Allows the user to select options related to current project.

DESCRIPTION

The options are available through a context menu. To access them, select the current project name and then right mouse click over it:

SuperDrive G2 offers three options via context menu:
- Rename
- Save As
- Close

9.1.1  Rename

ACCESS

Toolbar: none
Context Menu > Rename project
Shortcut Key: none
FUNCTION

Allows the user to rename current project.

DESCRIPTION

This option is available through a context menu. To access it, right mouse click over the current project name:

A dialog box is shown, asking for a new project name.

Case the new name already exists, system adds automatically an unique code to the end of name was typed.

9.1.2  Save As

ACCESS

Toolbar: 
Context Menu > Save As
Shortcut Key: Ctrl+D

FUNCTION

Saves a project with different name.

DESCRIPTION

Enabled when a project is created or opened.

When Save As function runs, a dialog is shown with the following information:

- Name - type a name for the new project. If the specified name is invalid or already exists, a warning message will be prompted.
- Location - a default location is shown, but can be changed.
- Folder - view only.
- Description - type the project description. It can be changed later in the Project Information.
9.1.3 Close

ACCESS

Toolbar:
Context Menu > Close
Shortcut Key: none

FUNCTION

Closes the project.

DESCRIPTION

If the project contains unsaved data, a save request dialog will be shown.
10 Libraries

Contents of this chapter:

JFreeChart

jSSC

10.1 JFreeChart

This software incorporates JFreeChart, © 2005-2012 Object Refinery Limited.

The JFreeChart home page can be found at: http://www.jfree.org/jfreechart/.

To read GNU Lesser General Public Licence, Version 3, access http://www.gnu.org/licenses/lgpl.html.

To get the complete source code of JFreeChart for the version of the library that it is used in this software please contact the manufacturer (see Contact).

10.2 jSSC

This software incorporates jSSC, © 2010-2012 Sokolov Alexey.

The jSSC home page can be found at: http://code.google.com/p/java-simple-serial-connector/.

To read GNU Lesser General Public Licence, Version 3, access http://www.gnu.org/licenses/lgpl.html.

To get the complete source code of jSSC for the version of the library that it is used in this software please contact the manufacturer (see Contact).
# Index

## - A -
- About 111

## - B -
- Before Installing 34
  - Before Trying To Establish Communication 214
- Bluetooth Connection 148
- Bluetooth USB Adapter 211

## - C -
- Close 49
- Communication 113
- Communication Setup 57
- Contact 7
- Contents 110
- Convert Project 101
- Copyright Notice 22

## - D -
- Drive 54
- Drive Parametrization 113

## - E -
- Edit Parameters File 65
- Ethernet Cable 210
- Ethernet Connection 173
- Ethernet Network Adapter 212
- Exception During Monitoring 214
- Exit 54
- Export 52
- Export Parameters File 69
- Export Trace File 96
- Export Trend File 92

## - F -
- Full Conversion Log 108

## - G -
- Getting to Know the Environment 19

## - H -
- Help 110

## - I -
- Identify Drive 55
- Import 51
- Import Database 101
- Installation/Uninstallation 34
- Installing 34
- Introduction 8

## - J -
- JFreeChart 218
- jSSC 218

## - L -
- Libraries 218

## - M -
- Main Window 19
- Menus 47
- Monitor Parameters 75
- Monitor Speed Reference 83
- Monitor Status 78
- Monitor using Keypad 77

## - N -
- New 48
- New Parameters File 64

## - O -
- Open 48
- Options 97

## - P -
- Print 53
- Project 47
- Project Information 53
- Project Tree 20
Index

- R -
Read Parameters from Drive  70
Remove  50
Remove Full Conversion Log  110
Remove Parameters File  68
Remove Simplified Conversion Log  108
Remove Trace File  96
Remove Trend File  92
RS232 Cable  207
RS232 Connection  130
RS485 Connection  133

- S -
Safety  22
Safety Notice  22
Save  49
Save As  50
Security System  63
Security System (Session)  64
Simplified Conversion Log  106
SuperDrive G2  6
Supported Drives  8
System Requirements  8

- T -
Tools  97
Trace  93
Trend  84

- U -
Uninstalling  41
USB Cable  207
USB Connection  116
USB Connection - Virtual COM Port  118
USB Driver  46
USB to Serial Adapter  210
User's Manual  18

- W -
Welcome  6
What's New  23
What's New in Previous Versions  23
What's New in this Version  23
Write Parameters to Drive  71